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About this user guide.

This document is not meant to teach you everything there is to know about 
ProPresenter. We hope that it will help answer many of your basic questions, or point 
you in the right direction to figure things out, but it’s not going to teach you everything. 
We have a lot of video tutorials on our website if you learn better by seeing and hearing 
rather than just reading, or if you want a combination of the two. Go to 
www.renewedvision.com/tutorials to view the videos. We also have a growing 
Knowledge Base and active User Forums. Both of these can be found in our Support 
Center by going to support.renewedvision.com. 

Most of the screenshots in this user guide were taken from the Mac version of 
ProPresenter 6. There may some slight variation in design, but the look should be close 
enough to understand what is being covered. We will update the user guide at times with 
new screenshots or to add missing content.  

http://www.renewedvision.com/tutorials
http://support.renewedvision.com


Downloading and Installing ProPresenter
Go to http://www.renewedvision.com/pro_download.php to download the latest version 
of ProPresenter for Mac and Windows. We also have a Version History section at the 
bottom of that page where you can download earlier versions of ProPresenter.

Click the blue Download Now button below the version of ProPresenter that you need. 
This will download the installer file to your computer. The Mac file will end with .dmg and 
the Windows version will be .zip. After the file finishes downloading, locate the file in 
your Downloads folder and double-click on the file.

Both installers will guide you through the installation process and may require you to 
enter your administrator user name and password to complete certain steps. Follow 
each step shown on your screen to complete the installation. Once ProPresenter has 
finished installing, you can begin using the program.

The only difference between a “trial”, “demo”, and “licensed” copy of ProPresenter is the 
license information. The software does not change. There are only a few limitations with 
the “demo” and “trial” version, which will be explained in the next section.
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Registering ProPresenter 6
In order to register ProPresenter 6 you will need to have a ProPresenter 6 license. This 
license can either be an upgrade from a previous version or a newly purchased license. 
You can also register the program with a two-week trial code.

The first time you open ProPresenter, you will see the window shown below. If you have 
a Trial code or have purchased a license, you will enter it here. If you are just taking a 
look at ProPresenter, you can click the Try It button. This will open the program with a 
watermark applied over the Output screen.

You can request a Trial code from our website. If you already have this code, enter that 
information here. The Trial code will remove the watermark from the Output, but you will 
not be able to purchase Modules or Bibles. All basic functionality is available, and you 
can demo the Modules or install public domain Bibles.

If you have purchased a new license or upgraded from a previous version, enter that 
license here as well. Once you register with a purchased license, you will be able to add 
Modules and licensed Bibles to ProPresenter.

You can change your license information at any time within the program by clicking on 
the ProPresenter 6 menu and selecting Registration. The Buy Now button will be 
replaced by an Unregister button. You can also select Upgrade if you need to change 
your license type. When changing the license information, you will need to have an 
active internet connection in order for it to be updated in our system correctly. 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Info Center
The ProPresenter Information Center is the first screen you will see when ProPresenter 
opens. It contains several actions and links to help you get started. You can always get 
back to the Information Center by selecting Info Center in the View menu from the top of 
the screen. To prevent the Information Center from opening every time, uncheck the box 
at the bottom of the screen.
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Free Media Content
We have partnered with WorshipHouseMedia to power the media store that is accessible 
directly through ProPresenter. If you have purchased anything from WorshipHouseMedia 
before, you will be able to use those credentials to log into the store, otherwise you will 
create a new account during the check out process that you can then use in the future to 
buy additional media.

To access the Store and the free content, click on the Store icon in the toolbar then 
select the RenewedVision Video Sample Download link. Depending on the size of your 
screen, you may have to scroll down a little to see this banner.
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The next page that loads will have a blue button that says “Add All to Cart”. Click that 
button to continue the process. The rest of the check out will be guided by on-screen 
prompts. Follow those until you get to the final download page then click the download 
buttons next to each bundle. They will automatically be downloaded into ProPresenter 
and will show up in your Purchased folder in the Video/Image Bin.

If this page does not load for you, try reloading the Store by closing the window and 
repeating the above steps.
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Configuring your computer for first use
If this is the first time you are setting up a computer to use ProPresenter, there are a few 
things you need to do first to optimize your experience. The most important thing is to 
make sure your screens are properly configured, which is covered below. There are 
some additional links to online resources that we think you will find useful while setting 
up your computer.

This section contains instructions for making changes to several system settings that we 
recommend all users configure your presentation system. The Mac instructions are 
written using OS X 10.11.2. The Windows instructions are based on Windows 8.1. There 
may be some variations for other versions of OS X and Windows, but these steps should 
give you a good idea of what to look for and change on your computer.
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Mac system settings
Display Preferences

The first step to getting your displays configured correctly is making sure that your 
system display preferences are set up properly. Before you begin, connect your primary 
output to your computer. Setting up the Stage Display will be discussed later in this 
manual in the Stage Display section.

To access Display Preferences, click on the Apple menu in the top-left corner of your 
screen and select System Preferences. Click on Displays to open up the display 
preferences.

After Displays is opened, click on the Arrangement tab. Ensure that the Mirror 
Displays option is unchecked.

The blue screen with the white bar at the top is your primary display. This is the same 
screen that ProPresenter will open on. This arrangement order is also used by 
ProPresenter’s Display Preferences panel when you assign your Output and Stage 
Display.

If you need to adjust the resolution of your screens, click on the Display tab and then 
click on the Gather Windows button in the lower right corner. Choose the Scaled option 
to access all available resolutions for each screen. Press the Option key while clicking 
on Scaled for even more supported resolutions. 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DVD settings
If you are using a new computer you may need to set the localization option for your 
DVD player. To do this, open the DVD Player application on your Mac and set the region 
option.

After you have done this, we recommend turning off the auto-play setting for DVDs so 
that ProPresenter and your computer don’t fight for control of DVDs. Open System 
Preferences and click on on CDs & DVDs. (If your Mac does not have an optical drive, 
you won’t have this option available.) Change the option for When you insert a video 
DVD to Ignore and then close System Preferences.

Desktop background
You may want to set your desktop background to a solid color (we recommend black) so 
that if ProPresenter stops working during service it’s less noticeable to your audience. 
You may like the desktop background that you have set, but it can be distracting during 
service if it ends up on the main screens.

Open System Preferences and click on Desktop & Screen Saver. Select the Desktop 
tab.

Each display needs to be changed individually. Unfortunately Apple has not provided a 
way to gather all of the desktop settings to your main monitor like you can with Displays. 
You will need to move your mouse to each screen and adjust the settings there or drag 
the window over to your computer screen.

Select the Solid Color option from the column on the left and then click on Custom 
Color to select black. Repeat this for each of your external displays.

Screen saver
Open System Preferences and click on Desktop & Screen Saver. Select the Screen 
Saver tab.

Change the Start after setting in the lower left corner to Never to prevent the screen 
saver from turning on.

Energy Saver
Open System Preferences and select Energy Saver. Adjust the settings to prevent your 
computer from going to sleep. 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Windows system settings
Display Settings

Windows has a couple different ways to configure displays. The simplest way is to hold 
the Windows-logo key which is next to the space bar and tap the ‘P’ key. This will open a 
window on the right-side of your screen with four different choices. You want to select 
Extend.

You can also right-click on your desktop and select Screen Resolution to access the 
more detailed display setup menu.

In Windows 10, click on Advanced display setting at the bottom of the window that first 
opens. You can adjust the Multiple Display option and the resolution for each display on 
the second window.

In Windows 8 you can adjust these settings on the first screen that opens. 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DVD settings
The first thing to do is verify that your computer is capable of playing DVDs. Windows 
8.1 requires an add-on from Microsoft and Windows 10 does not have a native DVD 
player. This also affects ProPresenter. If you have to use a third-party DVD player like 
VLC or another program, you may not be able to use DVDs in ProPresenter.

You can turn off Windows’ auto play settings by searching for AutoPlay from the Start 
screen in Windows 8 or from the search box in Windows 10. Locate the DVD settings 
and disable AutoPlay. This will prevent ProPresenter and your computer from conflicting 
with each other when trying to use a DVD.

Desktop Background
In Windows 8, right-click on your desktop and select Personalize. Choose the Desktop 
Background option at the bottom of the window. Change the Picture Location menu to 
Solid Color and select black.

In Windows 10, right-click on the desktop and select Personalize. You can change your 
background color on the first screen that opens.

Screen Saver
You will want to disable the screen saver to prevent it from turning on.

In Windows 8 you can access the screen saver settings by right-clicking on the desktop 
and selecting Personalize. Select Screen Saver at the bottom of the screen. Choose 
(None) from the list to turn off the screen saver.

In Windows 10, search for “Screen Saver” and select Turn screen saver on or off. 
Choose (None) from the list to turn off the screen saver.

Power Options
Search for Power Options. On the window the opens, select Choose when to turn the 
display off and adjust the settings to prevent screen and your computer from going to 
sleep. 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ProPresenter Preferences
This section will cover the Preference menu in ProPresenter 6. It’s likely that you will 
need to make very few changes to your Preferences beyond the initial setup.

Preferences are accessed by clicking on the ProPresenter menu and then selecting 
Preferences, or by pressing Command-Comma on a Mac or Control-Comma on a PC. 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General

Automatically Check for updates at startup

If this option is checked, ProPresenter will automatically check for updates when the 
program launches as long as you have an internet connection. If you don’t want to be 
notified of updates automatically, uncheck this option, but remember to check regularly 
for updates.

Crash Reporting

If you uncheck this section, the application will not attempt to submit crash reports when 
the application fails to work properly. If your computer doesn’t have a consistent internet 
connection, you may wish to disable this option.

Library Folder

This menu allows you to select from multiple libraries as well as add additional libraries. 
Adding additional libraries will be covered later in this guide in the section title Working 
with the Library. You can click on the magnifying glass to jump straight into the folder in 
your file system.

Logo

The ProPresenter logo is the default logo. You can change this by clicking on this button 
and selecting your own image. Having your organization’s logo or other image here 
provides you with something to go to in an emergency. Checking Preserve aspect ratio 
will maintain the aspect ratio of the logo image.
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Support Files

The Support Files is all the unique information about ProPresenter related to your 
settings. This includes templates, playlist data, props, etc. You can change whether this 
is stored for all users or only the current user account, or in a custom location.

The default setting is “Only this User”. In general, this information is kept unique 
between user accounts, however, if you have an administrator account and a standard 
user account, and want ProPresenter to be identical in each account, you can change 
this to “For All Users”. You will generally want to do this before you start adding content 
to ProPresenter to avoid any issues with your data.

The Custom Path option allows you to store this information in a custom location. This 
may be on a server or in a third-party cloud storage service, or even in a custom 
directory on your computer for other user accounts to be able to access the files easier.

Media Repository 

This is the directory where any media purchased through the store is downloaded to and 
where media that is imported with bundles is stored. Click the magnifying glass to go 
directly to the selected directory.

For All users, Only this User, and Custom Path use the same rules as the Support Files.

If you check the Manage Media Automatically option, any media that you add to 
ProPresenter will be copied to this location. By default this option is not checked, so any 
media added to ProPresenter doesn’t move the original files. If you enable this option, all 
media files will be added to ProPresenter and automatically moved into your media 
repository, preventing accidental broken links. If you already have a well organized 
media storage method, you may not want to enable this option.
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If you use the local Sync option you will need to enable Manage Media Automatically if 
you want to sync your media files. If you use the Cloud Sync option, this is enabled 
automatically when you first connect your account to ProPresenter.

Search Paths

If you need to move all of your media from on directory to another (e.g., ~/Desktop/ to 
~/Documents/), you can add a new search path. When you restart ProPresenter, the 
links to your media will all be updated.

Copyright

Copyright settings are covered later in this guide in the section called Copyright 
Settings. The settings here are the global settings for Copyright display.

Reset All Preferences

This resets all the custom settings made in Preferences. This will reset the settings on 
each tab in Preferences. After you reset preferences you will see a second option to 
revert to the previous preferences. We added a restore utility in case this was 
accidentally clicked or doesn’t fix the issue you were trying to resolve. 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Display

Display at Top Most Window Layer

Select this box to keep the ProPresenter output above any other windows on your output 
screen.

Scale to Fit Output Display

This will scale your presentation to the output resolution if they don’t match. 

Enable Stage Display

This will enable the stage display on the indicated screen. You can also enable the 
Stage Display screen by pressing Command-2 on a Mac or Control-2 on a PC.

Configure Stage Display

This will bring up the stage display layout editor. This is covered in more detail later.
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The Output (Out) and Stage Display (SD) outputs can be set within the Display 
preferences by clicking and dragging the indicators to the correct positions. Your 
computer screen is indicated by the white bar at the top of the box. Clicking on “Out” or 
“SD” will allow you to drag them to the correct screens.

System Display Settings

This will open the Display settings available in System Preferences.

Width, Height, Full Screen

These two boxes allow you to set a custom resolution for your primary output screen. If 
you want to use the full resolution, simply click the “Full Screen” button. This will use the 
resolution for the display that has “Out” assigned to it. If you are not using the full 
resolution, the arrows to the right will allow you to adjust the relative position of the 
output.

Screen Color

This specifies the default slide background color. This is the color you will see on your 
thumbnails and if no other background is selected. You can use any color.

Corner Pinning

Corner Pinning allows you to adjust each corner of the output independently. 
ProPresenter will calculate the distortion and adjust the image accordingly. This comes 
in useful if you need to make adjustments that aren’t available in your projector (such as 
horizontal or vertical keystoning). If your projector has the controls to adjust each corner, 
use those settings instead. Clicking Reset will undo all of your adjustments.

You can toggle Corner Pinning on and off with the check box next to the button on the 
main Display preference panel.
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Label

Group and Slide Labels

Labels are used to help you organize your slides in a song or presentation. You can add 
new labels and set their color in Preferences or by right-clicking on slides and selecting 
the label type you want to add. Click the plus icon to add a new label. Select the label 
name and press Delete to remove a label. You can also set any color you want for your 
label.

Group Labels are used with the Arrangement feature of ProPresenter (more information 
in the Arrangement section below). Group Labels can also be used to add Hot Keys 
automatically to your presentations. Hot Keys can be used to jump to a certain slide just 
by using your keyboard.

Slide Labels can be used to add short notes to your slide. Group Labels are generally 
used for songs to organize stanzas and to make it easier to arrange your song. A slide 
can have both a Slide Label and a Group Label as shown on slide 1 below. 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Planning Center Keys

If you use arrangements on your songs and you use Planning Center Online, then this 
feature can be used to speed up your process a bit, especially for new songs. This 
button doesn’t do anything if you’ve never created an arrangement in Planning Center. In 
fact, you will see this alert if you have no keys assigned to the Group you are selecting.

To use this feature, you will need to first log into www.planningcenteronline.com and find 
your song in the “Songs” list. Click on the song name or the pencil icon to the right of the 
name to bring up the Song Information screen. At the bottom of this screen click on 
“Default Arrangement” or “add new arrangement”. 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On the next screen you will drag the stanza names into the sequence list in the order 
than you want them arranged. This is similar to how you create a new arrangement in 
ProPresenter is you are already familiar with this process. When you are done, click on 
the “Save & Close” button. Be sure to add the song to your Planning Center plan that 
you will be importing. You are now ready to add the plan to ProPresenter.

If you are unfamiliar with adding a Planning Center Playlist to ProPresenter, please 
review that section of the user guide before continuing. This section will not cover how to 
add the playlist.

You will need to be logged into Planning Center inside of ProPresenter as well on the 
Services tab in Preferences as well as having the “Make Arrangements from Sequences” 
option selected there. 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You can prepare ProPresenter by making sure that you have the same Group names 
added to Labels before importing your service from ProPresenter. If you import a song 
from PCO that has a name that doesn’t exist in ProPresenter, you will see this message 
while importing your song.

For now, you can link the PCO Keys to any group that you aren’t using. You can also 
cancel the import and add the new groups.

If you take a look at the two previous screenshots you’ll notice that the chorus is called 
“Chorus” in PCO, but in ProPresenter it is called “Chorus 1”. This causes the PCO Key 
“C” to not be linked to a group automatically. You can click the dropdown to assign it to 
Chorus 1 and then it will be used correctly in the future.

The PCO Key for “Blank” doesn’t currently exist in the song, so you can assign it to 
anything for now. If you assign a key to a group that it doesn’t match, you will either need 
to rename the Group in Preferences or delete the key.

Once you have added a song with PCO Keys, you can go into the Label preferences to 
review the keys. Select a group name from the list then click on the Planning Center 
Keys button. This will show you a list of all the keys assigned to that label. If you have 
assigned a key to an incorrect group you can select it then delete the key with the minus 
button in the list.

The Planning Center sequence will be converted into a new ProPresenter 6 
Arrangement that you can select just like any other arrangement. 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Live Video

ProPresenter supports a live video feed over SDI or USB 3.0. We no longer support 
camera inputs that use Firewire. We officially support Blackmagic Design video 
interfaces, although other devices may work. We can only provide support for 
Blackmagic Design hardware as that is all we have tested.

For a list of supported Blackmagic devices, please visit support.renewedvision.com and 
search for “Blackmagic”. We have information for Mac and Windows users.

Video Device

Select the input device for your video source. This can be the FaceTime camera, an 
external camera, or a software “camera” like CamTwist or ManyCams.

Audio Device

Select the audio source (if needed) to be used with your camera.

Preserve Aspect Ratio

This prevents your camera input from being stretched full-screen if your output resolution 
and the camera resolution don’t match.
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Network

Enable Network

In order to enable any network services, this checkbox should be checked. The Network 
Name and Port will be set automatically. It is unlikely that you will need to change the 
port number. Generally you would only need to change the port if you need to 
specifically route ProPresenter’s network traffic through a certain port due to network 
management requirements.

Enable Master Control

The Master Control Module is an add-on module for ProPresenter. It allows you to 
control other instances of ProPresenter. This module will be covered in more detail in the 
Master Control section of this user guide.

Enable ProPresenter Remote

In order to use the ProPresenter Remote app for iOS and Android you will need to 
enable this and enable the mode that you want available. You will also need to set a 
password.
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Enable Stage Display App

In order to use the ProPresenter Stage Display app for iOS and Android you will need to 
enable this setting. You will also need to set a password.

Enable Text Stream for ProVideoPlayer 2

If you are using ProVideoPlayer 2, you can enable this setting for ProPresenter 6 to 
send it’s text output as a layer in ProVideoPlayer 2. Only the text from a slide is 
transmitted. Media, Messages, copyright info, and other slide objects are not sent via 
Text Stream.
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Sync
Local Sync

ProPresenter 6 makes it easy to sync files between computers, including files other than 
just your Library. This makes it much easier to setup a new computer with ProPresenter 
as well as being able to keep computers in sync with each other.

In order to sync your media files, you must have selected Manage Media Automatically 
from the Media Repository settings on the General tab in Preferences. Hot Folders will 

be included in the playlist data, but if the paths are different, the will not work after a sync 
to other computers.

The diagram below shows you the basic idea of how Sync works now. Before you can 
even begin syncing, you will need to have a central folder for everything to be stored. 
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This needs be a dedicated folder in a shared directory or on an external drive that is 
used only for syncing.

Once you have your central folder in place, use the “Sync files up” option on Computer 1 
to create the necessary sync folders and to copy the data. You will have up to five 
folders in your sync folder. After the sync is complete, you can use any of the sync 
options. If you are setting up additional computers to match the first one, you would 
select the central folder and choose “Sync files down” to move the files to that computer. 
In the future you would probably use “Bidirectional sync”.

Files that are deleted in one location are not deleted in the other locations when syncing. 
If you have deleted a song from Computer 2, and use Sync Down or Bidirectional Sync, 
the file you deleted will be added back to your computer. This Sync method only looks at 
the current file list to determine what needs to be synced each direction.

Sync files down from repository

This will move files from the Source to your computer.

Sync files up to repository

This will move files from your computer to the Source.

Bidirectional sync

This will look for differences between your computer and the Source and sync those 
files. The newest version of a file will be used if a file exists in both locations.

Replace My Files

This will replace any file with the same name using the Source version to replace the 
Destination version regardless of the Date Modified on either file. You should only use 
this if you want to “reset” any edits in the destination from a Master computer.

Sync

Click the Sync button to begin syncing your data. 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Cloud Sync
Cloud Sync Preferences

If you have not logged into a Cloud Sync account then this will be the first screen you 
see when you select Cloud Sync in ProPresenter 6's Preferences. If you need to 
purchase a Cloud Sync account, click on New Account to begin that process. If you 
already have an account, click Login.

Log into your Cloud Sync Account

The Login screen is the same as before. Enter your user name and password. 
Remember, each Cloud Sync account has a single username and password. Accounts 
do not support multiple users.
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Select your Sync Options

You can choose any combination of ProPresenter 6 data to sync. Choose those options 
here. You will also be shown these options again later and can change them at any time 
if you only need to complete a partial sync.

When you click Next, you will either be taken to the screen shown below or to step 4. If 
you are syncing a new computer to your Cloud Sync account, you will see the next 
screen. If this is the first computer you have linked to your Cloud Sync account, you will 
not see the next screen shown below. If you are adding this computer to an existing 
Cloud Sync account that has data uploaded, then you will see this screen.
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You can choose to sync your local data up to your Cloud Sync account, or sync the data 
from your account to the computer.
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Select which Libraries to sync

The first time you sync ProPresenter you will need to create new Cloud Libraries. This 
option will automatically be selected for you. If you have used ProPresenter Cloud Sync 
before, then you can either link a local Library to an existing Cloud Library, or create a 
new Cloud Library by clicking the dropdown menu. You can also select None from the 
menu to exclude a library Library from the sync process.
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Select Sync Options

These settings allow you to select whether your data has to be manually synced or if it 
can sync daily or hourly. These two options are based off the last completed sync time. 
You can choose to manually sync your data at any time, which will also reset the daily or 
hourly schedule. If you have a slow internet connection you may want to uncheck the 
option to Allow Multiple Transfers so that less bandwidth is used. You can also select 
Prevent Uploads if you don't want a particular computer to be able to change the data 
online. 
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Start Sync

When you click Start Sync, you will be taken to the main Cloud Sync preference panel. 
This is the screen you will see every time you open Cloud Sync on this computer again. 
You can modify all of the same settings from here that you configured during the setup 
process if you need to change your sync settings.

Sync status

As long as you are logged into ProPresenter Cloud Sync you can see the sync status in 
the toolbar. On a Mac, this is located at the top of your screen. In Windows, it's located in 
the System Tray in the bottom right corner of your screen. You can have your data sync 
even if ProPresenter isn't running by opening this utility and clicking Sync.
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ProPresenter Cloud Dashboard

You can log into your Cloud Sync account online by going to cloud.propresenter.com. 
You will be prompted to login using the same credentials that you used in ProPresenter. 
Clicking on Account Details in ProPresenter will also take you to this same page.
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After you log into your account you will be able to review your account status on the first 
page. The first screen shows you how much of your storage you've used and your 
transfer amount for the month. There are three additional pages inside your dashboard. 
App Data shows template files and template images, playlist data, stage display layouts, 
etc. Documents contains all of your Library files, organized by Library name. Media 
contains all of your Video/Image Bin and Audio Bin files.
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Managing files through the ProPresenter Cloud Dashboard

If you are close to your storage limit and want to manually manage your files, you can 
click the column header names (Name, Kind, Last Modified, Size) to sort the files in 
ascending or descending order by that column. This works for App Data, Documents, 
and Media. Every file has two management options. Purge will immediately remove the 
file from your account. It will still be available on your computer locally. Delete will flag 
the file to be removed on every computer when you sync again. Deleted files will 
automatically be purged after 7 days.

When you delete a file and then Sync ProPresenter, you will see an alert that one or 
more files are about to be deleted. If you don't want to delete a file, click Cancel and log 
into your account online and Undelete the file. If you want to remove the file, click 
Continue.

If you Purged a file online, it is removed from the sync log and will be uploaded again. If 
you removed a large file online, be sure to remove it from your ProPresenter Media 
Repository before syncing again.
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Managing files through ProPresenter

Media cues can exist in the Media Repository (set in Preferences) folder that are not 
shown in the Video/Image Bin or Audio Bin. These could be files you added directly to a 
presentation or playlist, files that were imported with a bundle, or files you removed from 
ProPresenter but didn't remove from the repository. When you delete a file from the 
Video/Image Bin, you will see this alert. If you select Delete Cues, then the cue is 
removed, but the file will still be in the managed folder.
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Services

Planning Center Online

If you use Planning Center Online you can login to access service plans and to use 
Planning Center Live features. There are a number of settings available for Planning 
Center. These will be covered in more detail in the Planning Center section of the user 
guide.

Social Media

Sign into Twitter to use these services in the Social Media section of ProPresenter.

SongSelect

If you are subscribed to SongSelect, you can login to search SongSelect’s entire catalog 
of songs directly from ProPresenter.
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Advanced

Import Video/Image Scale Behavior

These two options allow you to set the default scaling used for both types of media. This 
does not update media already in ProPresenter.

Video Playback

These two options are self-explanatory with the descriptions that are provided. If you are 
unsure about these selections, our recommendation is to leave them unchecked.

Audio

This section allows you to define how many channels of audio you are outputting. Most 
users will only have two channels, but if you are using a multi-channel audio device, you 
will want to change this number to ensure all of the channels are sent from 
ProPresenter. You can also adjust the Audio Delay, which may be necessary if you are 
outputting video over SDI.

Render Output Behavior / Render Output as Anamorphic 

This setting allows you to use 16x9 content in a 4x3 environment without distorting the 
original video. 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Modules

Any Module that you have purchased, either in an earlier version or in ProPresenter 6, 
will be available to activate. Clicking the Activate button will enable the Module. This 
same button will say Deactivate while the Module is in use. If you have a Campus 
License for ProPresenter you can move Modules between computers by activating and 
deactivating the mModule. An internet connection is required for this to work.

More specific information on each Module can be seen in their respective section 
below.

Demo Modules

If you click this button, all the Modules will be enabled in demo mode for the current 
session of ProPresenter. You will have the full functionality of the Modules, but the 
ProPresenter watermark will be placed on the output screen. When you close 
ProPresenter, the Modules will be turned off again.

Demo Modules add a watermark to the output screen while in use and are also reset 
when you restart ProPresenter. The Master Control Module has a 10 minute time limit.
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Toolbar
The Toolbar contains shortcuts for all of your most-used features in ProPresenter. The 
program comes with a default set of tools, but you can edit which ones are shown.

To adjust the settings for the Toolbar and the icons that are shown, right-click anywhere 
on the Toolbar or select Customize Toolbar from the View menu.

When you select Customize Toolbar, you will see a screen open with all of the 
available icons. Click and drag items to or from the Toolbar. You can restore the default 
Toolbar at any time by dragging the bottom row of icons to the Toolbar.
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Copyright Settings

ProPresenter makes it easy to display copyright information for songs. When you import 
a song from SongSelect, the data is automatically filled in. If you create your own song 
files, you can manually enter the copyright information if you want to.

There are two places that you need to configure copyright display. The first place is in 
Preferences at the bottom of the General tab. These are the global settings that apply to 
every presentation in the library. As you can see, you can choose to show the copyright 
information on the first, last, first and last, or every slide of your presentation.

The License # box on the right is for you to enter your church’s unique license number. 
You will need to contact CCLI for this number if you aren’t sure what it is.

To change the copyright elements that are shown (Title, Artist, publishing information, 
etc.) click on the CCLI Layout... button. This will open the options shown below.

Each of the copyright elements are controlled by “Tokens”, a feature in ProPresenter that 
allows text from one part of the program to be automatically shown by a different feature. 
The tokens on the left are the active tokens, meaning these are the ones that will be 
shown. The column on the right shows all of the options available. You can add and 
remove tokens from the left column by clicking and dragging them in and out of the right 
column. 

Clicking on Edit Template will open the Template Editor and allow you to format the 
position and text settings for your copyright information. Since tokens aren’t actually text, 
the only thing you’ll see in the text box is the copyright symbol. If you want to see how 
text will look formatted, add any text you want since this will be replaced automatically.
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Once you have configured how you want your copyright information to be displayed, you 
will need to make sure a presentation has information to display and that it’s enabled.

To access the copyright information, click on the blue “info button” next to the 
presentation title at the top of the slide viewer. If you need to change whether or not the 
copyright information is shown for a specific presentation, check or uncheck the Display 
Copyright box.

This information is used by the tokens that you enabled in the previous section. If you 
include a token but there is no information in that text field, nothing will be shown on the 
slide(s) that the copyright information is displayed on.

The Title entered here can be different than the name of the presentation in the Library. If 
you want to have multiple copies of a presentation, but show the correct copyright 

information for each presentation, just change the name of the presentation in the library 
and leave this as is. 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CCLI Reporting

To access the CCLI reporting feature, open Preferences, go to the General tab, and click 
on the Reporting... button at the bottom. This list will list every song that you have 
added into ProPresenter via the SongSelect feature.

You can reset this list to make it easy for you to track your songs during each reporting 
period. You can also export the list as a text file if you want to keep a backup copy of this 
list for your records. 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Presentation Layers

ProPresenter 6 presentations are composed of six layers.

Mask Layer

A Mask is a layer that hides everything behind it. Let’s say you need to project onto a 
circle screen or a really narrow screen, you could use a mask to black out everything 
outside the shape of your screen. Once a Mask is enabled, it stays active over the 
output as long as ProPresenter is open. You can create simple masks in ProPresenter or 
you can use editing software to create more complex masks and load them as .png files 
with transparency.

Props Layer

The Props Layer actually contains two different elements. The Props feature can be 
used to add text or images over top of your content, like a TV channel logo. Messages 
are also shown on the Props Layer.

Slide Layer

The Slide Layer includes everything you can add to a slide within the Editor. This is also 
the layer where Social Media, PowerPoint/Keynote files, and DVD content is shown.
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Video Playback

This is the layer where Backgrounds and Foregrounds (including still images and 
motions/videos) are shown.

Live Video

The Live Video layer uses the camera that you have selected in Preferences. It is also 
where the video input from the Alpha Keyer Module will be shown. If you are using live 
video without the Module, then your video source is cleared by Foregrounds or Clear 
commands. If you are live video with the Module, then the video input will always be live 
behind the rest of your content.

Background Color

This is the default color that you have set in Preferences on the Display tab. It’s the color 
shown when nothing else is on screen.
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Working with Templates
Templates allow you to quickly define a set of styles for your slides. ProPresenter 6 
comes with a collection of templates to help get you started.

There are a number of ways to select the Template that you want to use, so we’ll start 
with updating an existing set of slides.

To quickly change the appearance of a document, open it from the Library then click on 
the Template menu in the toolbar. By default, Template is on the far-right side of the 
Toolbar. Click the icon to open the list of available Templates. When you mouse over any 
of the groups you will be shown what the Templates look like within that group. Click on 
the Template you want to use from this list. Doing so will update all of the slides in your 
document. You can also select multiple documents and use this method to change 
several documents at once.

Don’t let the Default template name confuse you. This is simply the most basic style 
available. The last template you selected from any of the Template locations is what will 

be used—by default—each time, until you change it. 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New Template Group will prompt you to name your new Template Group and then 
opens the Template Editor. You can add as many Template slides within a Group as you 
want.

Save select slide(s) as Template Group does exactly what it says. If you have 
selected one or more slides (blue outline) and use this option, those slides will be saved 
to a new Template Group. This option is helpful if you have designed a slide in the Editor 
and need to create a new template to use for other presentations.

There are two options at the bottom of this main Template list that don’t show up in other 
areas that you can access Templates.

Size Text to Fit will dynamically resize the text on each slide to fill the text box. This may 
result in your text being different sizes on each slide.

Preserve Text Attributes will maintain the font color, bold, italic, and underline settings. 
The text size, font, and position will be changed. If the template you apply does not 
support bold, italics, or underlines, that property won’t be maintained.

Edit Template Group, Add Slide To Template Group, and Delete Template Group 
are straightforward and do exactly what they say.

In addition to the main Template menu, you can also select Templates while importing or 
creating new documents in your Library.
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You can also right-click on a slide (or select multiple slides then right-click) to change the 
Template. This works in the main slide view and in the Editor.

If you are adding a new slide, you can click the plus button at the bottom of the slide 
area or in the Editor to create a new slide with a specific Template (click the arrow) or 
with the last-used template (click the plus).

The Template Editor is very similar to the normal song Editor. You can add multiple text 
boxes and other slide objects. However, if you have a template with more text boxes 
than exist on the slides you apply the Template to, the extra text boxes will be added, but 
won’t show on the output. Other slide objects can be added via Templates. Backgrounds 
are not supported by Templates. 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Video/Image Bin
The Video/Image Bin is the location for managing your media within ProPresenter. 

To access the Video/Image Bin, click on the Video/Image icon in the toolbar, use the 
keyboard shortcut (Control-V for Mac, Control-Shift-V for PC), or select it from the View 
menu. Once the bin is open, you will find it below the slide area. The first time you open 
this, it will be empty, but once you have started adding content it will begin to look like 
the image below.

The Video/Image Bin is made up of two parts: the left column contains all of your 
playlists, folders, and tags; the right column contains all of your media cues.

All of your media files will be either a Background or Foreground. You can quickly 
identify the media type within documents by looking in the upper left corner of the 
thumbnail to see if it has the icon used by the Background or Foreground playlist. 

The chart below highlights three main difference between the two types of media. There 
are other differences that are covered in other sections of the user guide.

You can add media to the Video/Image Bin from your hard drive by dragging the files into 
ProPresenter or by clicking on the plus button below the thumbnail section. Dragging 
files in is the quickest way to add your files. You can also purchase media through the 
Worship House Media store by clicking on the Store button in the toolbar.

Backgrounds Foregrounds

Plays behind slide content. Plays in front of (replaces) slides and media.

Stretches to fill the screen. Scaled to maintain the cue’s aspect ratio.

Automatically loops at the end. Automatically stops at the end.
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If you want to allow ProPresenter to manage the organization of your files behind-the-
scenes, enable Manage Media Automatically in Preferences on the General tab. This 
will move or copy files (depending on the original location of the file) into the directly 
you’ve selected in Preferences. Refer back to the Preferences section for more 
information on this.

In ProPresenter 6 you can now tag media to help you filter your content the way you 
want. There are some default tags, but they can all be renamed and have the colors 
changed. You can also add your own custom tags.

In order to see the Tags, you will need to make sure they are enabled in Preferences on 
the Label tab.

To add an existing or custom tag, right-click on the thumbnail and choose the tag. When 
you select the Custom Tag option you will be able to name it and set a color.

You’ll notice in the image above that there are four playback behaviors. Loop and Stop 
have already been covered as the default settings for Backgrounds and Foregrounds. 
Next will advance the cue to the Video/Image Bin playlist that you have loaded. This 
playback behavior does not have any effect when you add a media cue to to a 
presentation. Soft Loop will smooth out the loop point for videos that don’t loop properly. 
It blends the first and last frames together to hide the jump that can happen when video 
loops aren’t created properly.

Similar to Next, the Go to Cue option only applies within the Video/Image Bin. You can 
select the next cue to go to in the current playlist and works with Foregrounds or 
Backgrounds.

Media Properties will open the Media Cue Inspector. This is covered in the next 
section.
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Transitions can be set globally for the Video/Image Bin, or on individual cues. To set the 
transition on individual cues, right click on a cue and select Transition.

Click the Transition menu at the bottom of the Video/Image Bin to set the global 
transition. This transition will effect all media cues in the Video/Image Bin. It will only 
effect Backgrounds in presentations. Foregrounds that have been added to a document 
will use the Document Transition instead. This is the only time the global transition for 
media is not used.

At the top of the Video/Image Bin you can search and sort your media. In the bottom-
right you can change the view from Thumbnails to List View and adjust the size of the 
thumbnails. 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Media Cue Inspector
The Media Cue Inspector allows you to adjust a number of properties for your video or 
still image.

To access the Cue Inspector, right-click on any media thumbnail and select Media 
Properties. If you added a media cue directly to a Library Playlist, click on the blue info 
button above the cue when it is selected.

The left side of the Cue Inspector shows you a preview of your media cue. If it’s a video, 
you will also have playback controls.

You can adjust the In and Out points on videos by adjusting the playhead position and 
clicking the In and Out buttons. This will change which portion of the video is used when 
you select it. Click Set Thumbnail to generate a new thumbnail where the playhead 
currently is. Click Reset In/Out to reset the custom In and Out points.

The button that says Built-in Output in the example above will be available if more than 
one audio output is detected. This option allows you to route the audio for previewing a 
video. It does not effect the routing of audio anywhere else in ProPresenter.

Click the magnifying glass icon next to the file path to jump to the media cue on your 
hard drive. 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The right column of the Cue Inspector is divided into three tabs. Each of these tabs gives 
you access to additional information or settings.

The first tab is the Info tab, shown in the image above. You can change the label of the 
media cue to something more practical and see the basic info about the file you’re 
working with.

The Field type option is only available for videos. Most videos will use the Progressive 
option. However, if you’ve encoded your video with an interlaced format, choose the 
appropriate Interlace option based on the field dominance that you selected during 
encoding.

You can also assign a specific transition to the current media cue on this panel.

The Source button allows you to change the media file being used. For example, you 
have a video called “Announcements” that has been added to ProPresenter, but you 
need to update it to a more current version. You can use the Source button to use a new 
video while maintaining all of the other cue properties you may have updated such as 
the In and Out points or video effects.

Page �  of �53 147



The second tab, Properties, allow you to adjust some basic playback settings.

The first option you can change the scaling behavior. The image below illustrates what 
each scaling option does. For the purpose of this illustration, a square image is used to 
exaggerate the effect that each scaling option has. If your media is the same aspect ratio 
or resolution as your output, the differences may not even be noticeable.

The first is Scale to Fit. If your media is a different aspect ratio, it will have bars (usually 
black) on either the sides or the top and bottom.

The second is Scale to Fill. This option expands the video to fill your screen and can 
result in cropping.

The third is Stretch to Fill, which fills the screen, but may result in distorting the image. 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Below the scaling options are two rotation options if you need to flip your media. If you 
are using a video, you will have the option to adjust the volume, play rate (speed), and 
playback behavior of the video here as well. The playback behaviors were covered in the 
previous section under the Video/Image Bin.

The final Cue Inspector tab is Effects. These effects can be used on videos or still 
images to manipulate the cue. You can apply multiple effects at the same time and many 
effects have additional options available once you select the effect.
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Presentation File Formats
ProPresenter has three basic file types. These formats are cross compatible between 
the Mac and Windows versions.

.pro6

This file extension is used on documents found in the Library. If you open up the folder 
where your Library is stored, you will see files such as “Amazing Grace.pro6”.

.pro6x

This file type is for ProPresenter Bundles. A ProPresenter Bundle is one or more songs 
exported from the Library that can include media.

.pro6plx

Exported playlists will use this extension. This is similar to the ProPresenter Bundle, but 
includes additional information specific to the playlist, such as Headers, active 
arrangements, and the order of documents in the playlist. Note that this might or might 
not include media, depending on which option the user selected when they exported the 
playlist. 

Page �  of �56 147



Media Browser

To access the Media Browser, click on View and then select Media Browser. You can 
also customize your toolbar and add a button or press Control-K on your keyboard to 
open it.

The Media Browser is no longer available in ProPresenter 6 on Mac, 
however it is still available for ProPresenter 6 on Windows.

To use content from the Media Browser, click and drag it to the slide that you want it 
applied to. Images, Audio, and Movies can only be added to presentation; you cannot 
use the Media Browser to add content to your Video/Image Bin. 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The Library
Before we get into how the Library works, you need to know how to add documents to 
ProPresenter. There are several ways to add documents to ProPresenter, but this covers 
the most basic way, which is manually creating a new document. You can also add items 
through SongSelect, Planning Center, Bibles, Social Media, or one of the built-in sync 
features. You can also import your previous libraries from an earlier version of 
ProPresenter if you have upgraded. All of those methods are covered in their more 
specific sections of the user manual.

To create a new document in ProPresenter, click on File and select New. You can also 
use the keyboard shortcut which is Command-N on a Mac or Control-N on a PC. There 
is also a shortcut on the toolbar to create a new document.

When you do this, you will see this window. Creating a new file will make a new file with 
a single blank slide. Give the file a name, select the Template, Category, and Size of the 
document. The Template will always be the last one used here and the size will default to 
match your output screen size. You can change any of these options as needed.

When you click New it will add the document to your Library and you can begin editing to 
add slides or media to the file. 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The Library contains all of your documents used in ProPresenter. This includes songs, 
Bible passages, sermons, presentations, announcements loops, etc. In general, there is 
no distinction between one type of document and another, with the one exception of 
Bibles. We use terms like “file”, “presentation”, and “document” interchangeably to mean 
anything in your library.

The Library is composed of two main pieces: the search bar and the documents list.

The search bar allows you to search your Library for any keyword or phrase. Search 
results are shown with a ranking to help you identify the most likely result. In the image 
below, “joy” is the keyword. As you can see, it ranks “Joy to the World” as the most likely 
result. You can click where it says Sort by Search Rank to change the order of the 
results as well based on Title, Category, Last Used Date, or Search Rank.
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To the right of the search field is an option menu.

Selecting a Filter allows you to change which documents are shown in your library. If 
you make use of Categories, this may be a feature you find helpful. When you select a 
category, for example, “Hymns”, only documents with that category would be shown in 
the Library.

Unchecking the Show detailed rows will remove the category shown below the 
document name, reducing the amount of space each document name takes up on 
screen in the Library.

Include SongSelect results in search will show SongSelect results at the bottom of 
your library if you are logged into SongSelect. Searching with this option enabled gives 
you quicker access to SongSelect. The image below shows what this looks like.

On the Windows version of ProPresenter 6 there is an additional feature called Include 
Contents in search which will allow you to enable or disable searching within the song 

text itself in addition to searching the song titles. 

The document list shows the song name, category, and the last used date. SongSelect 
results in the Library will show the author information instead of the category. 

Page �  of �60 147



Right-clicking on documents in your library will bring up a menu with a number of 
options. 

The first will open the file in your library folder outside of ProPresenter. It’s Reveal in 
Finder for Mac users and Open File Location for Windows users.

Export ProPresenter Bundle will generate a .pro6x file in the destination that you 
select. A ProPresenter Bundle includes the document and any media in the selected file. 
You can use this option on one or more files at the same time.

Export Slides as Images will give you a few options for how you want to export the 
slides. You can export as JPEGs with the background or PNGs without the background. 
You can also choose to include or ignore background media with your image export. The 
PNG option removes the background color and gives you a transparent image with just 
text on slides that don’t include media.

Rename lets you rename the file. You can also click twice (slowly) on the file name to 
rename it.

Category is allows you to select the current category for a document. You can also 
create a new category. Categories exist as long as at least one document in the library 
uses a certain category.

Resize will let you change the resolution of one or more files.

Select an Arrangement gives you a list of all the available arrangements for a song. 
You can use the Master arrangement in the library or you can select a custom 
arrangement to use as your “default” within the library.

Reflow Document opens the Reflow Editor.

Duplicate and Delete do exactly that. Deleted files will be sent to your trash bin on your 
computer. If you delete a file by accident you can restore it from the trash. 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Multiple Libraries
ProPresenter allows you to have more than one Library linked. Each Library also has its 
own set of Playlists.

To add additional Libraries, open Preferences and go to the General tab. Click the drop-
down menu for Library Folder and select Add/Edit/Remove.

When you select this option, you’ll see the next window shown below. Click the plus 
button to browser to the new folder you want to link as a Library to ProPresenter. This 
can be an empty folder or another ProPresenter 6 folder you have moved to this 
computer. Return to this window at any time to remove a linked Library by clicking the 
minus button.

You can also access the list of linked libraries and jump to the second screen by clicking 
on the File menu and selecting Change Library. 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Playlists
Playlists are located immediately below the Library section on the left side of 
ProPresenter. You can use Playlists to create the flow of your service or show.

The Playlist section contains Playlists, Group Folders, and PCO Playlists. For this 
section, we’ll only be discussing the first two. PCO Playlists are covered in the Planning 
Center Online section of the manual.

Playlists contain all of the elements of your event. This can be documents, media cues, 
and Headers. Group Folders are used to organize your Playlists. For example, you might 
have a Group Folder for “Liturgies”, “Sunday AM”, or “Wednesday PM”. Those folders 
would contain any playlists that you want sorted into each folder.

To add new Playlists or Group Folders, click the button in the bottom-left corner and 
select from the list. As you can see, this menu also includes options to create a New 
Document, New PCO Playlists, and New Headers.

Once you have added a new playlist, make sure it is selected, then drag files from your 
Library, pictures or videos from the Video/Image Bin, or audio files from the Audio Bin. 
You can also drag items between playlists.

If you want to organize your Playlists with Group Folders, add a new Group Folder, 
rename it, then drag playlists to it. If the Group Folder is selected, new Playlists will 
automatically be added into that folder. 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Planning Center Online Playlist
ProPresenter 6 includes integration with the popular Planning Center Services website. 
This means that you can easily collaborate on service plans outside of ProPresenter and 
quickly replicate those plans inside ProPresenter with multiple people. Planning Center 
is a subscription service and is not owned or operated by Renewed Vision. Visit 
Planning.Center for more information.

Not all of the features in a Planning Center service are supported in ProPresenter, but 
many of the most common ones are, including Planning Center Live.
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Working with Slides
Every presentation in ProPresenter consists of at least one slide, even if it’s just a single 
media cue. Each slide can tell you a lot about what is going to happen when you click on 
the slide, including the type of media cue, whether there are any Slide Cue actions, the 
Group or Slide Label.

Slides can be viewed in either the Grid or List View. To toggle these two views, click the 
view buttons in the lower right corner of the slide view area. Immediately to the right of 
these buttons is the slide scale slider. You can drag this slider to the left or right to 
change the size of the slide thumbnails.

Grid View is the default view for ProPresenter. As you can see in the image below, there 
are a number of visual clues on each slide to help you know what will be triggered on 
each slide. The first slide includes a Stage Display layout cue. Clicking this slide will 
change the layout being used for Stage Display. The next two slides have the same 
video attached, but the first instance is a Background and the second a Foreground. The 
icon in the upper left corner on each slide matches the icons used in the Video/Image 
Bin to identify Backgrounds or Foregrounds. Videos are indicated by the timecode in the 
bottom left corner. The second slide also has a custom transition for the slide that will be 
used when that slide is clicked, as shown in the bottom right corner. The active slide is 
outlined in orange.
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List View is similar to Grid View, but you also get a plain text view of the slide text in 
addition to the thumbnail. This view uses the same icons to indicate Slide Cues, media 
types, and transitions. This view also includes any Slide Notes that you have added to 
your presentation. The active slide is orange, and more obvious than in the Icon View.
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There is also a new Slides by Group option in ProPresenter 6. This option is available 
at the bottom of the slide view area and works with Grid or List View, although it works 
best with Icon View.

Rather than all of your slides being mixed together, they are broken down into their 
individual groups and shown with more separation. If you are using an Arrangement, 
each instance of a group in the Arrangement will be separated. This view can be helpful 
if you don’t have a pre-set order for the song and want to be able to quickly find each 
section of the song. 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Groups and Arrangements
Groups and Arrangements make it easy for you to create multiple versions of a single 
song without having to save several files in your library. This feature allows you to define 
slides as part of a stanza (Group) and then arrange them in whatever order you need.

Once you start using Slide Groups, every slide in that presentation must be part of a 
Group. By default, all of the slides start in a generic Group called “Group”.

To get started, right-click on a slide and select a Group Name. If you have 8 slides and 
start on the first slide, all 8 slides will be grouped into the selected group. If you start on 
slide five, the first four slides will remain in the generic “Group” and the last four slides 
will be in your selected Group, for example “Verse 1”. This second scenario is shown in 
the image below. 

You can right-click on any slide to start a new Group for the slides between that slide and 
the next Group. If slide three is selected above and named “Chorus”, only slides 3 and 4 
will be affected. Slides 1 and 2 are still part of “Group”.
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Groups can be renamed by repeating the naming process and selecting a new name. 
Groups can also be split into additional groups by right-clicking on one of the slides and 
selecting a new Group. In the image below, the last four slides have been split up into 
three groups, with slide five being the only one that is still part of Verse 1. 

You can also turn on the Arrangement feature by clicking on the button in the top right of 
the document that looks like a flow chart. This will show each Group represented by its 
own button (“Token”).

Once you have grouped your slides into the correct Groups, you can make adjustments 
if necessary. When you drag slides around in the presentation you will see left and right 
arrows that are the same color as the Group that you hovering over, or a vertical teal 
colored bar that indicates you are adding the slides between Groups. The image below 
shows moving a slide into the red group, as indicated by the red arrow. Hold the Option 
key while dragging will duplicate, rather than move, the selected slide.

If you duplicate a group in the presentation, you will see a new group added to the 
Arrangements toolbar. This new group will function independent of the other one even 
though the name is the same. You may want to change the name on this new group to 
make it clear which one you are using in the Arrangement. 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To create a new Arrangement for your presentation, open the Arrangements toolbar and 
click on the options menu on the left and select Add New Arrangement. You will be 
prompted to name this new Arrangement.

Once you have created your new Arrangement you will need to drag the Groups into the 
order that you want to be shown in that new Arrangement. Click on the Tokens in the top 
row and drag them to the second row to organize your Arrangement.

 
If you repeat a Group in your aArrangement, any edits made to one of those instances 
will apply to the others. For example, if you have Chorus in your Arrangement five times 
and add a background to the first slide of the Chorus, it will be added to the other 
instances of Chorus. This also applies to any changes made to the text on a slide. These 
changes are also reflected in other Arrangements that use the same Group. The 
properties of an Arrangement are not unique to that specific Arrangement.

Due to how Arrangements are stored within the song file, you can actually have the 
same presentation in your playlist multiple times with a different active Arrangement 
selected for each instance of the presentation. To change the Arrangement, right-click on 
the presentation in the playlist and select the Arrangement from the Select an 
Arrangement list. You’ll see the Arrangement name in [brackets] at the top of the 
presentation when you open as you can see in the image above. The selected 
Arrangement is stored as part of the playlist data, so exporting the playlist will maintain 
the proper Arrangement when you open it on another computer.
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Document Properties
Every presentation in your Library has the ability to support additional data about the file. 
This will typically only be used for songs since the primary data is copyright information.

To access this information, click on the blue Info button to the left of the presentation 
name in the slide viewer. When you click this button, it will open the panel shown in the 
image below.

This information is automatically included on any song imported from SongSelect, or that 
has the copyright information properly formatted in a text file. The copyright information 
is used when displaying the copyright information, which is covered in another section.

Notes that are added here are shown at the top of the presentation in a dark gray bar 
above the title. Notes are useful if you need to include a general reminder about 
something related to the presentation for the person running ProPresenter.

In addition to the copyright information and the chord chart, you can also change the 
default slide color, size and category of the current presentation if you need to. Clicking 
the blue Info button a second time will close this panel. You can also access some of the 
same information in the Editor which is covered in its own section below.

Chord charts can be attached at the document level of any presentation. You would want 
to attach a chord chart this way if you have a single page to show. If you have more than 
one page of chord charts for a presentation, you will want to add those through the Slide 
Editor and attach them to specific slides, which is covered in its own section below. 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Transitions
Transitions can be applied to slides (documents) and media in ProPresenter.

Slide Transitions are used for any content shown on slides and for Foregrounds within a 
presentation. The Media Transition is used for any Backgrounds in presentations, media 

cues added to a Playlist, and media in the Video/Image Bin.

Both transition sets can be applied globally from the main interface. To set the global 
slide and media transitions, click the scissor icon at the bottom of the screen. The one 
on the left is for slides, the one on the right is for media.

Slide transitions use blue icons to indicate the transition type.

Media transitions use green icons to indicate the transition type.
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Some transitions include a setting for the direction of the transition and an option called 
Motion Extended which allows the transition animation to continue after the cue reaches 
the screen. This creates the sensation that the text or media exists in 3D space and 
continues further than the screen.

The global transition settings are available at any time from the bottom toolbar of 
ProPresenter. If the Video/Image Bin is open, the Slide Transition setting will be at the 
bottom of the slide area and the Media Transition will be at the bottom of the Video/
Image Bin.

Documents feature the ability to override the global setting so that all slides on that 
document would use their own transition. If you normally use a one second Dissolve 
transition but need to use a different transition setting for a certain document, you can 
set the Document Transition in the upper right corner of the presentation.

You can also override both the global setting as well as the document setting on 
individual slides; simply right-click on a slide and select Transitions from the menu. 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Similarly, you can set individual transitions for media cues in the Video/Image Bin. Right-
click on any cue and select Transitions to set specific transitions.

You can also open the Cue Inspector for any media cue and set the transition there as 
well.

Page �  of �74 147



Resizing Presentations
There may be times when you are given a presentation to use in ProPresenter that was 
created on a different computer that had a different output resolution set. When this 
happens, you will see a yellow triangle in the upper-right corner of the slide viewer. 
When you click on this alert, you’ll see a message like the one below telling you what 
size the document will be resized to. All slide elements will be scaled correctly to 
maintain the same look on your slides.

If you need to resize a lot of presentations at the same time, you can select multiple files 
in the Library, then right-click and choose the correct size from the Resize menu. If one 
of the four default options doesn’t work for you, click on Custom Size and enter the 
correct dimensions.
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Editing Presentation Slides
ProPresenter offers a few ways to edit presentations. Individual slides can be changed 
using Quick Edit, the overall look of a presentation can be changed using the Format 
menu, or you can make extensive edits using the Editor. Templates can also be used to 
change the look of a presentation which is covered in the Template section.

The quickest way to edit a slide is with Quick Edit.

The Quick Edit function allows you to make simple changes to individual slides. This is 
useful if you find small grammar or spelling mistakes or realize you need to change a 
line break or other simple change. The Quick Edit window is a small, floating edit window 
that opens when you right-click on a slide and select Quick Edit. You can continue 
selecting on other slides while this is open. Clicking the ‘X’ in the top-left corner of the 
Quick Edit window applies the change to that slide immediately. 

The second way to edit a presentation is with the Format toolbar. This button is located 
on the right side of the toolbar by default.

As you change the different formatting options, the presentation you’re working with will 
be updated immediately so you can see the changes. If you need to make changes to 
multiple presentations, just click the Apply All button as you select the rest of the 
presentations to apply the same settings again.

The Editor is the most robust way to edit a presentation. Here you have full access to 
the slides and can modify the contents of the slides and edit all of the various properties 
of the presentation. Since the Editor is a WYSIWYG (“What You See Is What You Get”) 
editor, what you are seeing in the editor is exactly what will be shown on your output. 

To open the Editor, click on the Editor button in the toolbar, or right-click on a slide and 
select Edit Slide.

To begin editing a slide, select the slide you want to work with from the thumbnails on 
the left side of the Editor. This will change the slide that is open in the Editor. If you are 
done editing a presentation and need to edit another one, you can select the other 
presentation without having to close the Editor. You can also edit presentations even if 
you have another one running as a slideshow loop or have any slide or video showing.

Use the buttons in the lower-left corner to add new slides as needed. These two buttons 
are the same ones from the Slide Viewer.

The first seven buttons across the top of the Editor are used to add slide objects. These 
objects are: Text Box, Shape, Image, Video, Live Video, HTML Web Page, and Text 
Ticker. Slides in ProPresenter can support any combination of these objects on an 
individual slide. Click on the object that you want to add to the slide, then resize and 
position it where you would like it to be on the slide.
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There are more options available for the Text 
Ticker. The Text Ticker can display plain text 
that is manually entered, it can be linked to an 
RSS feed URL, or it can show plain text that is 
stored in a local file. 

You can specify the speed at which the ticker 
moves as well as the behavior of what 
happens when the ticker reaches the end. 
Loop Immediately will cause the ticker to 
begin right away after finishing, such that the 
first letter will appear immediately after the last 

letter. Loop with Delay will cause the ticker to finish playing completely, and then begin 
again. Do not Loop will play the ticker once and not loop it again.

The rulers button in the toolbar displays rulers on the left side and top of the Editor to 
make it easier for you to size and position objects on the slide. When you have the ruler 
mode open, you can click on either ruler and drag away from it to create an Editor 
Guide. This is a blue line that will persist on all other editor screens. Objects on slides 
will “snap” to these guides, making it easy to manually position objects in the same place 
on multiple slides

The last two buttons are used to change the arrangement of layers on the slide. The first 
is Bring Forward and the second is Send Backward.

If you are trying to center an object on the slide, yellow crosshairs will show up when you 
have reached the vertical and horizontal center points.
 
If you want to change the zoom level of the slide, click on the zoom menu in the lower-
right corner and select a new zoom level. By default this is set to Scale to Fit so that you 
can see the entire slide regardless of your screen size or layout. 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Slide Element Cropping/Zooming
In ProPresenter 6, it is now possible to crop/zoom individual media elements on slides. 

To do this, after importing media to a slide as a slide object, double click on the media 
object so that the “handles” on all of the sides and corners of the object turn black. Now, 
just drag any one of the handles, and you will see the image move within it's preset 
frame and you can adjust the portion of the image that you want to see. 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The column on the right side of the Editor is where most of the functionality 
exists. There are five different sets of properties that you can change.

On the left most tab you can override the default background color set in 
Preferences for this one presentation. You can also change the size of the 
document and the category of the presentation.

If you set a transition it will apply for the entire presentation and override the 
global transition.
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The second tab is Slide Properties.These settings apply to the current slide 
only.

If you need to disable a slide, uncheck the Enabled box. If you need to 
change the background color of an individual slide, you can do that by 
enabling the Background option and selecting a color. Hot keys are used to 
trigger slides using your keyboard; these can be any letter from A to Z.

The slide label shows up as the name of the slide. These are an additional 
way to label slides (in addition to Groups/Arrangements) and are great at 
naming specific slides.

If you set a transition here it will apply to just this slide.

If you have multiple objects on a slide, it can become difficult to keep track 
of the order of the object. Clicking on the layer will select the object that it 
goes with on the slide so you can identify which object is where.

If you need to use multiple chord charts throughout the presentation, add 
them to the appropriate slide that they need to be shown with.

The third set of properties are Slide Build Properties. Each object on a slide 
can have a separate transition when it is brought “In” to the slide and when 
it is sent “Out” from the slide. To add a transition, select the object in the 
editor and pick a transition in this panel. 

Each object with a selected transition will appear in this list.

An individual object can be set to transition “With Slide”, “On Click”, “With 
Previous”, or “After Delay”.

With Slide means that the object will use the selected build transition, but 
will appear as soon as the slide is first launched.

On Click will allow subsequent clicks after the first time the slide is clicked 
to bring in the objects.

With Previous will link objects together so that one click will bring in 
multiple objects.

After Delay will bring an object in after a specified amount of time (i.e. 3 
seconds).
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The fourth tab is the Object Properties tab. This is where you adjust the 
general properties of objects that you have selected on the slide.

The top section of allows you to change the coordinates of an object’s 
position, as well as its size, rotation and opacity.

The Name label will name the object that is selected. This is helpful if you 
want to tell multiple objects on a slide apart, and is also used to apply 
Social Media Templates and Bible Templates.

The Fill Color is used to change the color of a shape or the color of a text 
box. Fill Color also supports opacity. The Line Color changes the outline of 
the object or text box and Line Width is the thickness of the line. Corner 
Radius controls the roundness of the corners of an object or text box.

The Shadow settings can be used on slide objects or on text. The Angle of 
the shadow is what direction you want the shadow to come off the object or 
text. The dial next to Angle allows you to quickly adjust the position of the 
shadow. Length controls how far away from the object or text the shadow is 
and Radius controls the blurriness of the shadow. 

Tip: A high shadow radius value may cause performance issues with intricate fonts.

If you have a shadow applied to text, and then add a fill color to the box, the shadow will 
move from the letters to the text box automatically. So if you need to have the shadow 
on the text and a colored box behind it, you will need to add a shape object behind the 
text box. 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The fifth set of properties are the Text Properties.

The top section allows you to choose your font, font color, font styles, and 
color. You can also add an outline to text and select an outline color.

Tracking and Leading may be two terms you aren’t familiar with. Tracking 
refers to the amount of space between the letters in a single line 
(horizontal spacing). Leading refers to the amount of space between lines 
of text (vertical spacing). Leading is not supported by the Windows version 
of ProPresenter, so this setting won’t transfer between platforms.

The next area controls the alignment of the text. The first row is the 
horizontal alignment of the text and the second row is the vertical 
alignments. Checking Adjust to Fit will dynamically resize the text box as 
needed.

If you click Apply All, all of the settings on this panel will be applied to the 
other text boxes in your presentation.

One of the primary reasons many of our users still use PowerPoint for their 
Pastor’s sermon notes is the need for bullet lists and fill-in-the-blank slides. 
Text Reveal was added to make it easier to build those kind of slides.

To use the Text Reveal function, select either Bullet List or Fill in the Blank 
from the drop-down menu. This will change the functionality of the selected 

text box. Use Bullet List to have each line from a slide animate separately onto the 
slide, while Fill in the Blank will have underlined words/phrases appear on the screen 
one at a time. It is not possible to combine the two functions in a single text box.

Line Background (available for Mac only) automatically shows a rectangle on the 
screen behind the text. This feature allows you to show separate bars/lines behind each 
line of text automatically. Using this feature you can show a solid color for the hight of 
the text and not the entire text box. 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The sixth properties tab is the Image/Video Properties tab. This tab can 
only be accessed if you have an image, video, or live video object on a 
slide.

If you have added an image or live video to the slide, only the top section 
will be shown. 

You can change the source of the file while maintaining any other value 
you’ve set for the object. If you need to find out where an image or video is 
located, click on the magnifying glass to open the file location.

The drop-down menu allows you to select different scaling options for the image or 
video. These options change the way the image or video is displayed within the 
boundary of the object’s box.

If you have a video object selected, you will have the second set of options available. If 
you need to change the way the video plays, click on the Behavior menu and select 
Stop (arrow with a line), or Loop (arrow in a circle).

The Volume slider will change the volume of the video if there is an audio track. The 
Rate slider will change how slow or fast the video plays. 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Go to Next Timer
A common need in ProPresenter is the ability to create an announcement loop from a 
series of slides, graphics, or short videos. There are two easy ways to do this. The first is 
to use a Go to Next Timer, the second is to use the Timeline (which will be covered in 
its own section).

A Go to Next Timer can be applied to slides, images or videos in a presentation. A timer 
can’t be applied to media in the Video/Image Bin.

While using a Go to Next Time is simple, it does take a little bit of prep work to make 
sure it works the way you want it to and the way you expect it to work.

Before creating your timer it’s important to know the difference in how a Go to Next 
Timer works with Foreground video versus Background videos.

Backgrounds: If your video is a Background, a Go to Next Timer begins counting 
from the start of the video. This means that if your video is 30 seconds long, but 
your timer is set to 10 seconds, then the video will only play for 10 seconds 

before advancing. If your video is 30 seconds long and your time is 45 seconds, then the 
video will play one complete time and then advance halfway through the second time.

Foregrounds: If your video is a Foreground, a Go to Next Timer begins counting 
at the end of the video. This means that when your video ends, then the timer is 
triggered. If you have a 30 second video and a 10 second timer, your video will 

play completely one time, then wait 10 seconds before advancing to the next item. If you 
want the videos to play one right after the next, set the timer to 0 seconds.

You can set a timer from two different locations. The easiest option is from the toolbar. 
Click on the Clock icon in the top right of your slide area and click the desired length for 
each slide in your document; this will apply the time to all the slides in a presentation as 
well as add a loop to first slide to the last slide.

The second, and more flexible, option is to select all the slides that you want to add a 
timer to, then right-click on any one slide, and choose Go to Next Timer from the menu. 
You can enter any value, in seconds, that you want to use for the transition time. 
Remember that if you are using Foreground videos and want them to advanced 
automatically, use zero seconds.

If you need to enter different values for individual slides, you can edit the timer settings 
for each slide. If you want your presentation to loop continuously, check the box next to 
Loop to first slide on the last slide in your presentation.

If you have added a timer or loop cue to a slide, it will be shown in the upper right corner 
of the slide so that you can quickly see what the settings are for that slide.

When you are showing slides with a slide timer, you will see a stop sign icon with a clock 
on it under the playback controls. Clicking this button will stop the timer from running 
until you click on a slide again. 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Hot Keys
Hot Keys allow you to assign specific letters (A through Z) to slides. Some users prefer 
to assign letters to certain parts of songs to make it easier to quickly jump between 
sections. To add alphabetical hot keys to slides, right-click on a slide and choose Hot 
Key from the menu. This will open a window that allows you to assign any lowercase 
letter to that slide. You can also edit the hot key assigned to a slide in the Editor from the 
Slide Properties tab.

You can also select slides using a numeric keypad or the number row on your keyboard. 
To jump to any slide, type the slide number and press Enter on your keyboard. The slide 
will be selected immediately. The slide number is found in the lower left corner of the 
slide thumbnail.

You have two seconds between key strokes to enter another value. After two seconds, if 
the enter/return key has not been pressed, the hot key trigger window will automatically 
close. Pressing the escape key will also close this slide selection overlay. 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Saving Files
ProPresenter will auto save all changes. The auto save feature works in the background 
and is triggered any time a change is made. The change will be saved within a few 
seconds. If you make a change and close ProPresenter before the auto save function 
has a chance to save your changes, you will be prompted to save your changes upon 
closing. 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Slide Reflow Editor
Whether you're changing the flow of a song's text during import or creating a new 
version of an existing song in your Library, ProPresenter 6's Text Reflow functionality 
gives you a complete view of a song's text on the left hand side and a slide view on the 
right. You can easily change line breaks, slide breaks, add labels in this text edit view. 
You can see how the changes make your slides look as the slide view updates with your 
changes. This is a substantial time saver versus having to edit on a slide by slide basis.

Reflow can be accessed three different ways. When you first import a song to 
ProPresenter (from a file or SongSelect) you can click on the Edit button in the lower left 
corner of the Import window to open Reflow if you want to edit the song before importing 
it. If a song is already in your library or playlist, right-click on the file name and select 
Reflow Presentation... from the list of options. You can also select Reflow 
Presentations... from the File menu. Any of these three methods will open the same 
window shown above.

The left side of the window provides a text layout of the presentation making it easy for 
you to quickly see the text and manipulate the slide breaks. New slide breaks can be 
entered by clicking the Insert Slide Break button at the bottom or by pressing Option-
Enter on a Mac or Control-Enter on a PC. Slides breaks are entered where the cursor is 
located. To remove a slide break, click in front of the text following the break and press 
the delete key. This will remove the break and merge the two slides back together.

If you need to make more edits to a slide, such as change a slide’s Group, then you can 
click on the arrow on the right side of the dividing line between slides to access the full 
right-click menu for that slide.

Reflow is designed to work with basic presentations with a single text box on each slide. 
Presentations with slides that have multiple text boxes will not work properly with Reflow. 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Chord Charts
ProPresenter 6 includes the ability to attach chord charts to presentations. This can be 
done at the document level or per slide. To attach the presentation at the document 
level, access the Document Properties by clicking on the blue Info button at the top of 
the slide viewer. To attach a chord chart at the slide level, open the Editor to a specific 
slide, then select the Slide Properties tab (the second from the left) from the top right.

Click on the box next to Chord Chart and then 
click on Add Chord Chart. This will open a file 
browser window; browse to the location of your 
PDF and select it. 

If your PDF is a single page it will be added right away. If it’s a multi-page PDF, you will 
see the window shown below. Select the page that you want to link to a specific slide 
from the column on the right, then click Save to use that page. If you want to import 
different pages of a single document to different slides, you will need to select each page 
for each slide. As with media, when a PDF is linked to a slide, it will be shown until a 
different PDF page is selected; therefore if you have multiple slides for a stanza, you 
only need to add the PDF to the first slide of the stanza. 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Importing and Exporting Files
This section will cover the various import and export options available from the File 
menu in ProPresenter 6. 

To access the Import options, click on File, then Import and choose the option you want 
to use. You can also drag files from the Finder directly to the Library or Video/Image Bin 
to start the import process. 

The different Export options are at the bottom of the File menu. You can also export files 
by right-clicking on a document or playlist and choosing Export or dragging the 
presentation or playlist to a folder to your computer.

Import File

This option is used to import text files (.txt or .rtf), Word files (.doc or .docx), or other 
ProPresenter document files (.pro5 or .pro6).

After selecting a file to import, you will be shown options for importing.
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“Slides delimited by” allow you to specific a number of lines or paragraphs per slide, or to 
use a custom slide break marker in the source file.

Regardless of which delimiter you use, the number placed in the “delimiter(s) per slide” 
determine when new slides are generated. If you have selected “Line Break” and enter 
“2”, you will end up with two lines on each slide, with respect for stanza breaks. Same 
with paragraphs. If you have used a customer delimiter such as “//” or “*” in your file, just 
type that into the “Slides delimited by” field. 

The middle section allows you to update the size, category and template that will be 
used for the file you’re importing.

You can also decide if you want the file to go to the Library, to the selected Playlist, or to 
a new Playlist. If you choose New Playlist you’ll be prompted to enter a name.

The button in the lower-left corner opens Slide Reflow.

Import Text from Clipboard

This option uses the same import options as Import File, but allows you to copy text 
from a website or a file such as a PDF or other file type not supported by ProPresenter 
and import it into the Library.

Import PowerPoint

If you have PowerPoint installed on your computer, you can convert PowerPoint files into 
formats ProPresenter can use. 

PowerPoint 2011 or newer must be installed on the computer for this feature to work.  
You must have PowerPoint 2016 or newer to use this feature on macOS Mojave.

 
Once you have located the PowerPoint file that you want to convert, choose the option 
that you want to use before clicking Open. (You may need to click on Options in the 
lower left to show the import options that are available.)

PowerPoint importing will be covered more in-depth in another section.

Import Video/Image

This option opens a new file browser window. Navigate to the video or image that you 
want to import and select it. The file will automatically be added to whichever bin or 
playlist is currently selected in the Video/Image Bin.

Import Library from Previous Version

This option will open a window showing the document library from ProPresenter 4 or 
ProPresenter 5 if there is an older version currently installed on your computer. This will 
allow you to select a library to import and convert to ProPresenter 6.
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Importing these files does not affect your previous files, so you can import the files while 
you are getting ProPresenter 6 configured without affecting the previous versions.

Export Document

There are several ways to export an individual document or multiple documents that 
have been selected.

As Bundle
Bundles are used to gather Library files and media files together into a single 
package that can be opened in ProPresenter on another computer running 
ProPresenter 6. If you select multiple songs in your Library, they will all be 
included in the same bundle along with the media. Importing bundle file will add 
the documents to your library.

As ProPresenter 5
This option exports the file for use in ProPresenter 5.

As ProPresenter 6
This option exports the file natively for use on another computer running 
ProPresenter 6.

As Plain Text
This option will export the select presentation(s) as a plain text file with a .txt 
extension. This export method strips all formatting except line and paragraph 
breaks.

As Slide Images
This option will export each slide in the document as a JPEG image (with 
background color) or PNG image (without background color). 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Export Templates

ProPresenter 6 makes it easy to export templates to be used on another computer. 
Instead of having to search through the Finder to find these files and manually add them 
on another computer, you can export specific templates to a single bundle file. When you 
double-click this file on another computer, the templates will be imported and be 
available for immediate use.

Export Playlist

This option will export the selected playlist. When you export a playlist you can choose 
to include the media with the playlist if you want. Importing a playlist on another 
computer will rebuild the playlist exactly the way it is on the original computer. Playlists 
can also be exported by right-clicking on the playlist name, or dragging the playlist name 
to a folder on your computer. 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Printing
ProPresenter 6 offers two printing views: Thumbnail View and Outline View. When you 
open the print dialog you’ll need to expand the print options to see these features.
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SongSelect
SongSelect is owned by Christian Copyright Licensing International (CCLI). If you are an 
active license holder of a CCLI license for your church or organization then you have the 
option of purchasing a subscription to SongSelect.

For more information about CCLI and SongSelect, visit www.ccli.com.

If you have access to SongSelect, ProPresenter can store the registration information for 
you and provide direct access to SongSelect through the program. This makes it easy to 
get songs from SongSelect without having to leave ProPresenter.

You can search using SongSelect by selecting SongSelect from the View menu.

In ProPresenter 6, you can also search for songs in SongSelect directly from the Library 
search box. To do this, be sure that you have checked “Include SongSelect Results in 
Search” in the Library preferences (accessed by clicking the button to the right of the 
search box).

In either of these search interfaces, you can search by title, author, keywords, or CCLI 
number.  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PowerPoint and Keynote Importing and Triggering
Importing PowerPoint Files

To import a PowerPoint file, go to the File menu, select Import, then select Import 
PowerPoint. Select the PowerPoint file that you want to import from the file browser 
window. At the bottom select the option for importing (on Mac you may need to click the 
Options button see these options):

Import Native PowerPoint file (PC only)
Will play back directly in PowerPoint (see Triggering section on next page)

Import All Slides as JPEG Images
Compresses each slide down to a still image for use in ProPresenter

Import Text Objects as ProPresenter Slide Elements
Import only the text from PowerPoint to ProPresenter

Import Text and Graphic Objects as ProPresenter Slide Elements
Import the text and objects from PowerPoint to ProPresenter

Click on Import to bring the PowerPoint file into ProPresenter using the selected options. 
All of the above options (except for Import Native PowerPoint file on PC) will create a 
new document inside of ProPresenter and will no longer need to open PowerPoint to 
show that file.

On a Mac the Import Native PowerPoint File option is not available, but you can 
achieve similar results by dragging the PowerPoint file directly from the Finder to a 
playlist inside of ProPresenter. This will use the Triggering feature explained on the next 
page.

PowerPoint 2011 or newer must be installed on the computer to import PowerPoint files.  
You must have PowerPoint 2016 or newer to use this feature on macOS Mojave.

Importing Keynote Files

To import a Keynote file, simply drag the Keynote file from the Finder into a Playlist. This 
will use the Triggering feature explained on the next page.

Playback of Keynote files is only supported on a Mac, 
and Keynote must be installed on the computer to use this feature. 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Triggering PowerPoint and Keynote Files

Some times you want to use a PowerPoint or Keynote file yet you want to keep the 
animations and transitions of the original file. To do this you can select the Triggering 
option of ProPresenter; on a Mac drag the file directly onto a playlist from the Finder, on 
a PC go to File, Import, Import PowerPoint, then select the Native option at the bottom.

Before you use this feature, be sure you go to the Display tab in Preferences 
and uncheck Display at Topmost Window Layer.

On a Mac, when you select the PowerPoint file in the playlist, you will see a Play button 
in the Slide area. Click on this Play button to open PowerPoint/Keynote and run the file 
natively. Once this happens you leave ProPresenter and are 100% in the appropriate 
application. To close the app press the Escape key.

On a PC this feature is slightly different in that you will be able to see previews of the 
slides in your slide area, and you can click on individual slides to show them on the 
screen.

Due to limitations with PowerPoint and Keynote, ProPresenter is triggering the 
presentation and relying on the appropriate program to play the presentation. This 

means that while a PowerPoint or Keynote file is being shown, it is PowerPoint/Keynote 
that is controlling the output and therefore any content within ProPresenter (Mask, 

Props, Messages, etc) can’t be shown over the output content. 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Bibles
Registering and Downloading

To register and download a Bible, click the gear icon on the top right of the Bible tab, 
click the Bibles menu on the left, click on Purchased or Free tab, then click on Install for 
the appropriate Bible. Note that all purchased Bibles are licensed per computer, so if you 
want to have two computers with the same version, you will need to purchase two 
licenses.

Searching

There are three ways to search for passages in the Bible window. You can select from 
the Book menu, search by a specific passage, or use a keyword search.

Before searching, you need to select a specific translation from the menu on the left. To 
use the passage selector, click on the Book menu, then choose a book and chapter of 
the Bible; this will load all the verses in that chapter. To search for a specific range of 
verses, type in the passage and press Enter. The Bible passage search also recognizes 
shortened versions of book names (IE: “Matt 1 2 3” will perform a search for Matthew 
1:2-3). To do a keyword search, type in your search term in the search box on the right.

Display Options

As with songs and other presentations, you can apply a template to Bible passages to 
format them the way you need. Bibles also include several extra settings that are unique 
to Bible passages.

• Show Verse Numbers: Checking this option enables verse numbers to be displayed 
in Bible passages.
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• Break on New Verse: Checking this will create new slides for each verse of a 
passage.

• Display Translation: Checking this option will show the translation that is being 
used.

• Preserve Font Color: Checking this option will retain “red letter” words and other 
formatting in the Bible text.

• Verse Refs: This option is only available if Break on New Verse is selected. 
Selecting this option will display the verse reference on each slide.

• Passage Each: Selecting this option will show the reference for the entire passage 
being shown on each slide.

• Passage Last: This option will only display the passage reference on the last slide.
• No Reference: This option doesn’t display the passage reference on any slide.

Bible Presentations

The Bible window is designed to make it easy for you to find verses on the fly in the least 
amount of time possible. You can quickly search for verses through several different 
look-up methods, and begin displaying those slides moments later.

Once you have found the passage that you want to use, click on the action menu in the 
lower-left corner and choose either Save as Document or Copy to Current Document. 
The Save as Document option will create a new presentation in your Library with the title 
of the passage. The Copy to Current Document option will add the passage to the 
document that is currently selected in the library or a playlist. This option makes it much 
easier for you to prepare a single presentation for a sermon.

You can easily add the previous or next verse to a passage by clicking on the Previous 
Verse or Next Verse buttons. These two buttons are available in the Bible window as 
well as on Bible presentations in the Library.

ProPresenter 6 allows you to use a single format for your verse and reference, or create 
two unique styles for the verse and references. All of this is done through the use of 
Templates.

To create a new Bible template that supports individual styles for the reference and 
verse text, click on the Template button then choose Create New Template. This will 
open the Template Editor, which is similar to the standard Editor.

Once the editor is open, add two text boxes to the slide and format the text how you 
want each part to look. For the example below, each text box has had a line added 
around the box to make it easier to see the two boxes.

After you have created your two text boxes, the next step is to name the two boxes so 
that ProPresenter knows how to use this template in the Bible winodw. To name each 
box, select the Object Properties tab on the right, select one of the text boxes, then 
choose either Bible Text or Bible Reference from the Name menu. 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Props
Props make it easy to leave items on screen for an extended time, but are also easy to 
clear at any time. Some common uses for Props may be a lower-third graphic, a logo in 
the corner of the screen (sometimes called a “bug”), or other persistent graphic that you 
want to leave on screen.

A Prop can remain on screen for just one slide, multiple slides, or for as long as you 
want. This layer is independent of other layers allowing Props to be triggered at any 
moment. Props adhere to transparency settings for those graphic formats that support 
them (such as PNG files and animation videos with an alpha channel).

To open the Props window, customize the toolbar to add the Props icon, select it from 
the View menu, or use Control-P (Control-Shift-P on a PC) on your keyboard.

To activate a Prop, click on the Prop thumbnail. You can clear individual Props by 
clicking on the Prop’s name in the toolbar. If you want to clear all of the Props at once, 
add the Clear Props button to the toolbar and use that. (The Clear Props button is not 
included in the default toolbar.)

If you want to change the Props window to a floating window, click on the icon in the top-
right corner. To return it to a docked position, click on the same corner again.

The first button in the lower-left corner is the Edit button. Clicking on this will open the 
Props Editor where you can create as many Props as you need. The second button 
allows you to set transitions for the Props. The slider in the lower-right corner changes 
the size of the thumbnails. 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Clocks
The Clocks window serves two purposes. The primary purpose is controlling clocks that 
are seen only on the stage display. The second is controlling countdown clocks that can 
be shown on the stage display, in a Message, or both. 

To access the Clocks window, customize the toolbar to add the Clocks icon, select it 
from the View menu, or use Control-C (or Control-Shift-C on PC) on your keyboard.

This section will cover the basics of how this window works; using clocks and 
countdowns on the Stage Display and in Messages will be covered in their own sections.

Current Time Format allows you to choose the way you want to display the system 
clock inside of ProPresenter.

Below that you can add an unlimited number of countdown clocks by pressing the plus 
button at the bottom right of the Clocks window. Each of these clocks can be set to 
Count Down Timer, Count Down to Time, or Elapsed Timer.

Count Down Timer: a standard countdown clock that runs for a given amount of time
Count Down to Time: allows you to indicate a specific time to countdown to
Elapsed Time: allows you to count up from a specific time, keeping track of the total 
time

If you change the time, click the Reset button to the left of the clock to update the time. 
Clicking Stop will pause the clock. Overrun allows a clock to continue running past zero. 
The buttons at the bottom will start, reset, or stop all of the clocks simultaneously.

If you want to change the Clock window to a floating window, click on the icon in the top 
right corner. To return it to a docked position, click on the same corner again. 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Messages
ProPresenter allows multiple messages to be formatted and ready to go on-demand and 
even display multiple messages on the same screen simultaneously with different 
formatting for each message. To open the Messages window, click on the Messages 
icon in the toolbar, select Messages from the View menu, or press Control-M.

If you want to change the Messages window to a floating window, click on the icon in the 
top right corner. To return it to a docked position, click on the same corner again.

There are two views available for the Messages window. The initial, collapsed, view 
allows you to easily change the content of a message or a countdown clock. You can 
choose various messages from the drop-down menu.

When you open the Messages window, you can click on the drop-down menu to select 
from any message that has already been created. If you need to add a new message, 
click on the plus button. To edit a message, click the edit button to the right of the new 
message button.

Messages work using a combination of predefined text and token text. Tokens create 
content dynamically depending on your needs. There are some included tokens, and 
you can add any custom token that you need.

The image to the left shows a message that can be 
used to ask parents to come to the nursery. Along 
with the predefined text, there is also a token in 
use. Using tokens makes it easy to create 
messages that need to be updated regularly.

Instead of having to type this entire message every 
time it’s need, the person running ProPresenter 
would only need to enter the information required 
from the Token (in this example the Name); this 
allows the message to be shown faster.

The bottom row of buttons control showing and 
hiding a message, as well as the transition that is 
used when displaying a message.

The second function that the Messages window serves is to create on-screen 
countdowns for your audience. If you don’t want to buy a countdown video for an event, 
ProPresenter makes it easy to format a countdown clock that can be used over any of 
your own content.

As with regular messages, countdowns can contain text and a countdown. If you don’t 
want the clock to show extra zeros at the front as time runs down, check the Strip 
Leading Zeros option.
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In ProPresenter 6, it is now possible to input data to tokens through an HTML page 
accessed through the local network. An example of this would be for a nursery worker to 
send a Message request without having to leave the nursery. To do this, first check 
“Enable Network” in ProPresenter Preferences > Network. Next, check the “Visible on 
network” checkbox next to the Message name in the Messages window.

The HTML page can be accessed by clicking the small computer icon on the right side of 
the messages window. The address of this page can be shared with nursery workers or 
anyone who may need to provide remote input of tokens.

When a message is entered remotely, a notification will appear on the ProPresenter 
operator’s screen. Clicking this notification will immediately display the notification on the 
screen. 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Mask Layer
The purpose of a Mask is to allow you to “mask” (or cover up) a part of your output to 
create custom projection screens or to keep the projector from projecting onto something 
that you don’t want it to. Masks are also perpetual items in ProPresenter; when you 
enable a Mask, the Mask will be enabled (even through restarts of ProPresenter) until 
you turn it off.

To access the Mask window, customize the toolbar to add the Mask icon, select it from 
the View menu, or use Control-Shift-M on your keyboard.

Only one Mask can be active at any time. The Mask feature also has its own transition 
time, but it does not have transition effects. To enable a Mask, click on the thumbnail. To 
clear it, you must return to this window and click the Clear Mask button or select the 
Clear Mask option from the Actions menu. There is no keyboard shortcut to clear a 
Mask.

If you need to create more advanced Masks, you can use Photoshop or other editors 
export the file out as a PNG with transparency, and import it into a Mask inside of 
ProPresenter. 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Audio Bin
The audio bin allows you to control audio playlists directly from inside ProPresenter 
without having to rely on an outside application to play music or sound effects.

To open the Audio Bin, click on the Audio icon 
in the toolbar, select Audio Bin from the View 
menu, or press Control-A (Control-Shift-A on 
PC)

There are several components of the Audio 
Bin. At the top are playback controls. Any 
audio file played from the Audio Bin or added 
directly to a slide are controlled from here. 

The next part of the Audio Bin lists the folders 
and playlists used to organize audio files. You 
can create Playlists to organize your audio 
files, and Group Folders to organize your 
Playlists. To add a Group Folder or playlist, 
click on the ‘+” button.

The lower section lists all the songs or sound 
effects in the selected playlist. Clicking on the 
name of a file will trigger the audio to start 
playing. A search box allows you to quickly 
locate any item in the selected playlist.

Clicking the “+” at the bottom of the Audio Bin 
will open an import window for you to select 
tracks to import. You can also drag files 
directly from your computer to the Audio Bin.

You can also specify that audio from the bin or a selected playlist be shuffled by clicking 
the Shuffle button at the bottom right corner.

Each audio file that you add into ProPresenter can be assigned one of two playback 
options:

Audio Tracks are best for longer audio files such as songs and background music. Only 
one Audio Track can be played at any time; playing a new Audio Track while one is 
already playing will clear the first to play the second. You can control (play, pause, etc.) 
Audio Tracks from the top area of the Audio Bin.

Sound Effects are better for shorter files such as sound effects. Multiple Sound Effects 
can be played simultaneously, and once a Sound Effect has been triggered you cannot 
control it (except for selecting Clear Audio or Clear All).
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The type of audio file is selected by default based on audio length. Longer files are Audio 
Tracks and shorter files are Sound Effects. Right-click on the file to bring up a contextual 
menu to change the audio files type.

If you want to change the playback behavior, you have three options: Loop, Go to Next, 
and Stop. To change the behavior, right-click on the file and select the Behavior menu.

Either audio type can be dragged onto a slide to create an Audio Cue in the same 
manner as media cues. When a slide with an audio cue clip is clicked, it will 
automatically play the audio clip. These clips are controlled by the playback controls in 
the Audio Bin. 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Timeline
ProPresenter 6 makes it easy to sequence slides in a timeline with or without an audio 
track. This makes it easy for you to create presentations with custom timings between 
slides or to record the slides to match a song. The ability to sequence slides with music 
is especially useful for worship leaders who don’t have a band or someone to run lyrics 
for them since the song and lyrics can be started with a single click.

To begin this process, open the Timeline by clicking the Timeline button �  at the top of 
a song.

There are three ways to add slides to a Timeline. The first is to drag the thumbnails from 
the presentation to the Timeline. The second is by clicking on the Slide Show button in 
the lower-right corner of the Timeline and selecting a preset value. This will space all of 
the slides out at the same interval. The third way is to click the Record button and record 
the slides live.

Audio files can be added to the Timeline by clicking the Audio Track button, dragging a 
file from the Audio Bin, or dragging a file from the computer to the Timeline. After you 
have added an audio track, you’ll see a solid green bar with the song name added and 
the duration value in the upper right corner will show the total length in seconds. To 
remove an audio file, click on Audio Track and select Remove Current Track.

To record the slides live, click on the Record button to ready the timeline for recording, 
then press the play button when you are ready. If you have added an audio file, the 
audio will begin playing. To record slides to a Timeline, click on the slides like you 
normally would when going through a presentation. 

The Timeline has a hidden feature that isn’t available anywhere else in the program. If 
you trigger the same slide multiple times, each word will highlight in yellow during 
playback, creating a karaoke or sing-along effect with the words. Click once for each 
word when that word is sung before moving to the next slide.

If you find that the audio track is playing too fast for you to accurately record the slides, 
you can manually move the slide cues when you’re done, or you’re can slow down the 
song with the Rate slider. This will cause the song to play slower so that you can have 
more time to anticipate slides.
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When you have finished recording a presentation, click the record and playback to stop 
the recording. If you need a Timeline to loop, click on the loop button to the left of the 
Duration time box. Entering a value in Offset will move all of the slide cues by a given 
amount. Duration can only be changed if there is no audio file attached to a timeline.

Clicking the info button in the upper right corner of a cue will let you change the cue label 
and see any sub-cues that were recorded as part of the cue. The Seconds slider 
changes the time scale of the timeline so you can see more or fewer slides at once. 

Page �  of �107 147



Scheduler
The Scheduler allows you to schedule specific items to play at a specific time, and you 
can even set the Scheduler to repeat every week!

�

To access the Scheduler window, customize the toolbar to add the Scheduler icon, 
select it from the View menu, or use Control-s (Alt-Shift-S on PC) on your keyboard. You 
can click the button in the top right to make it a separate window or to dock it back to the 
main window.

Use the “+” button to add a new schedule; select a schedule and click the “-“ button to 
delete it.

To Schedule an item, first it must be listed inside of a Playlist. Once the item is a part of 
a Playlist, select the Playlist from the Select a playlist… dropdown menu, then select 
the item itself from the right hand dropdown.

Below that you can set the date and time for when the item will fire, and to the right you 
can select if this schedule will repeat or not.

Note that if you use the Repeat option, ProPresenter must quit 
and be opened again between repeats for the Scheduler to work. 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Using DVDs
ProPresenter makes it easy to use a DVD during your presentation by allowing you to 
select specific clips for playback from a DVD. It is also possible to rip a DVD so that the 
clip needed is stored on the computer instead having to rely on a DVD working properly 
or having to use third-party programs to rip DVD clips.

There are two ways to use DVD content in ProPresenter. The first way is to create clips 
from the DVD. When you create a clip, you aren’t saving the DVD content to your 
computer, you’re simply creating reference points to the DVD; the DVD must be in the 
computer in order for a clip to be played. 

To access the DVD window, customize the toolbar to add the DVD icon, select it from the 
View menu, or use Control-D on your keyboard.

Play the DVD as normal using the standard DVD controls at the bottom of this interface. 

To create a DVD clip, click the Set buttons on the bottom right of the interface to set the 
start and end points of the DVD clip. If you need to reset either the start or end point, 
click Clear and reset the points. Next, choose a name for your clip and press the Save 
button. 
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Saved clips are shown in the column on the right. You can view clips for the mounted 
disc only or click on the Show All DVD Clips checkbox to show all DVD clips that have 
been created in the application. Selecting a clip will load it in the DVD interface. Once 
you have saved a clip, you can click and drag it into a playlist or a slide and it will be 
shown like other media.

Once you have saved a DVD clip, you can play it by clicking on the thumbnail in the 
column on the right or after you’ve added it to a playlist or slide. If you want to show an 
entire DVD and would rather just play it directly without making a clip, click on the Full 
Screen button next to the Eject button.

The DVD must be in the computer for a clip to be used. Saving a clip only creates a 
bookmark for the clip on the disc. However, if you would rather not rely on the DVD to be 
in the computer, you can actually rip DVD clips with ProPresenter.

Preparing to rip a DVD clip is the same as saving a clip. Set the in and out points and 
name the clip, but instead of clicking on Save, click on Rip. You will see a progress bar 
while the clip is being ripped.

Before ripping a disk, you will need to install the HandBrakeCLI.

When a DVD clip is ripped, the entire chapter that contains the In and Out point will be 
ripped. As you can see in the illustration below, the orange segment represents the part 
of the DVD that is selected to be shown. The In point is in Chapter 1 and the Out point is 
in Chapter 2. Both of these chapters will be ripped in their entirety, but ProPresenter will 
automatically set the In and Out points on the final clip to the correct spot. The DVD clip 
will be placed in your Foregrounds bin in the Video/Image Bin. If you need to adjust the 
in or out point, you can do that within the range of the video that was ripped.

If you are using an SDI card to send your output signal from ProPresenter you will not be 
able to use this feature. DVD playback isn’t rendered the same way as other content in 

ProPresenter, and can’t be shown via SDI. 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Displaying Web Pages
ProPresenter 6 allows you to easily share a live web page with your audience. The 
software provides a web browser within the interface that is mirrored to the output 
display without all the extra interface pieces such as address bars, bookmarks, and 
other distracting elements, so the focus remains on the content of the page itself.

You will need to add the Web browser icon to your toolbar, select it from the view menu, 
or press Control-W to access the web browser.

Click on the Show button in the top right corner of the browser to immediately display 
the webpage for the audience to see. You can then interact with the website within the 
browser on your computer and your audience will be able to see what you’re doing.
 
The toolbar also contains basic browser functions: Back, Forward, Refresh and Go. The 
globe allows you to create a bookmark cue in a playlist by dragging the icon to a playlist. 
The square button on the far right allows you to switch the browser window between a 
docked screen or a floating window.

If you are using an SDI card to send your output signal from ProPresenter you will not be 
able to use this feature. Web pages aren’t rendered the same way as other content in 

ProPresenter, and can’t be shown via SDI. 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Stage Display
The Stage Display feature provides a “foldback”/“confidence” monitor so that the people 
on stage can receive information such as the Current and Next slides, clocks, timers, 
notes, chord charts, and even custom messages that only they can see.

This feature requires an additional video output from your computer. Many computers 
can use the standard video outs of their computer, but if your computer does not have 

enough outputs then you can use a USB adapter to create a Stage Display.

To enable the Stage Display output, open Preferences and select the Display tab. If all 
three of your displays are active, you will see three boxes on the Display preferences 
screen. Check the box next to Enable Stage Display; this will activate the Stage Display 
output.

At this point, a purple box labeled SD will show on display preferences. This box may 
become active on the wrong screen when you enable the stage display. If this happens, 
click on the stage display box and drag it to the correct box representing your stage 
display.

Pressing Command -3 will switch ProPresenter’s preview window to show a preview of 
the Stage Display instead of the normal ProPresenter output.

There are three ways to access the configuration for stage 
display. The first is by clicking on the Configure Stage 
Display button on the Display preferences screen. The 
second is by selecting the Window menu and choosing 
Configure Stage Display. The third is by pressing 
Command-4 (Control-4 on a PC). All three of these methods 
open the same configuration display that is shown to the left.

At the top of the Stage Display Options window is a listing of 
all the available stage display layouts that you have created. 
To add a layout, click the plus button on the right. To copy a 
layout, select the layout and click the copy button (below the 
plus button). To remove a layout, select the layout and press 
the delete (or backspace) key on your keyboard.

Anyone who is using an iOS device with the stage display app 
can select from any available layout. Only one layout at a time 
can be used with a wired stage display.

For the Current Slide, you can select to show “text only”, 
“static slide” or “live slide”.

Text Only will show just a text version of the slide.
Static Slide will show a thumbnail of all images and other objects on the slide.
Live Slide will show the slide exactly as it appears on the output display, including video.
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Slides notes are added in the Editor on the Slide Properties tab. If no notes are entered, 
nothing will be shown in the Slide Notes boxes.

When you enable the stage display option to show chord charts, a new box will be 
added to the layout. You can move and resize the box to fit your needs. Chord charts are 
only shown for the presentation they are associated with. When you change to a 
presentation without a chord chart, the box will be empty. Adding chord charts to 
presentations is covered earlier in this user guide.

The clock and countdown settings for stage display are linked to the Clocks window in 
ProPresenter. You can start any clock from the Clocks window, or if you have a 
Countdown Message that uses a clock that is enabled on the stage display, it will start 
with that clock as well. 

Clocks on the stage display are useful for showing how much time is left before an event 
starts and for showing a speaker how much time he has left. If you would like to change 
the color of each clock or countdown on the stage display, you can do that from here.

Video Countdown shows the time remaining on the currently playing video. This feature 
is helpful for those on stage to know how much time is left in a video, such as a 
countdown video or intro video. When enabled, it runs for Background and Foreground 
videos.

Strip Leading Zeroes changes the clock display from 00:05:30 to 5:30. Clocks also 
support a function called Over Run, you can now have the clock change colors when it 
passes zero if you have Use Negative Color enabled.

The next section of options control how stage display messages are shown. Stage 
Display Messages are unique because these are only shown on the stage display. In 
ProPresenter 6, you can change the color of the box when it flashes, or you can disable 
the flashing effect entirely.

To access this feature, open the View menu and select Stage Display Control, add a 
button to your toolbar, or press Command-Shift-S (Alt-S on PC). Type your message and 
click the Send Message; the Message box on the stage display will show the message 
and flash if you have that enabled. Clear will remove the message completely and Hide 
removes the message from the stage display, but doesn’t delete the message.
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In ProPresenter 6, it is now possible to display the countdown time, current item, and 
next item as linked from Planning Center Live. 

To use the Planning Center Live feature, you must have a Planning Center Online 
account and have configured your plan using the Planning Center website.

To begin using this feature, be sure that you have linked your PCO account in 
ProPresenter Preferences > Services. Next, select a PCO service to link from the Stage 
Display Control window. From here, you can advance through elements of your PCO 
Live Plan. The items on the ProPresenter Stage Display will also advance if the Planning 
Center Live plan is updated from another device. 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Social Media
ProPresenter 6 includes the ability to search for and display results from Twitter directly 
through the program. You can search by keywords or hashtags, and moderate which 
results are shown on screen.

Facebook (the parent company of Instagram) has halted the ability for third-party 
applications, such as ProPresenter, to do queries and display of Instagram user feeds. 

As such, we have removed the Instagram information from this document. 
Our recommendation is to log out of your Instagram account (via the Services tab  

of Preferences) and to not use the feature as it may crash the program. 
 

You can read more via the official statement by Renewed Vision here.

To open the Social Media window, click on the Social Media button in the toolbar, select 
it from the View menu, or press Control-Shift-S (Control-Shift-W on PC).

To begin, login to your Twitter account.

Then you can begin searching for tweets to show on screen. You can search for a 
keyword or by using a hashtag. 

There are a few general options for the Social Media window.

Auto Approve Results will approve all results immediately for display. It does not 
require manual moderation of what appears on screen. 

Auto Remove on Show will show an item once and then remove it from the list to be 
shown. If this box is not checked, an item will continue to be shown, in rotation with the 
others, until it is manually removed.

Save Approved Items allows approved items to persist even if ProPresenter is 
restarted.
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Highlight Hashtags/Users allows hashtags or usernames to be highlighted in a 
different font color from the rest of the text.

There are also a few options for each of the Social Media Services. For Twitter:

Include Historical Search allows older results to be searched and used. If you have 
authorized ProPresenter to access your Twitter account, the results will be updated in 
real-time.

Checking Ignore Retweets will ignore tweets using the new retweet styling as well as 
messages that start with “RT”. 

Checking Ignore Links will ignore tweets that contain a URL.

Once you have search results available you can remove results, ignore them, or approve 
them. Clicking the X will remove a results if it isn’t relevant or you don’t want to see it, 
and clicking the check will approve the content. Approved content is moved to the 
column on the right and go into the display rotation.

As with slides and media, you can also set a transition for your approved content. Click 
the transition menu in the top-right corner and pick from any of the available transitions; 
these work just like slide transitions.

Once you have approved content, you can set the Slide Duration to be up to 60 
seconds long before the next item is shown. If you need to clear the list of approved 
tweets, click the Clear Approved button.

The formatting of individual content is handled by templates. Several templates are 
included with ProPresenter 6. Individual templates can be set for Twitter, and the correct 
template will be used when displaying the relevant content. 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Telestrator
ProPresenter 6 introduces an exciting new feature, the Telestrator.

This handy new feature allows you to draw on top of your live output in real time using 
any of 4 "tools". Using the pen tool, you can sketch any freehand drawing or you can use 
the circle tool to make quick, perfect circles. The spot tool draws focus to a particular 
part of the screen inside of a circle, and the laser tool functions like a laser pointer, 
allowing you to virtually "point" to anything on the screen.

The tools, their size, and their color, can be quickly selected from the menu bar at the 
top of the Telestrator.

With the Telestrator app for iPad, you can allow anyone to draw on the screen remotely, 
too. Connecting wirelessly, you can see the live output from ProPresenter and draw in 
real time. 

Page �  of �117 147



Record Output

ProPresenter 6 now allows you to record everything shown on ProPresenter’s Output 
Window directly to a file. The filename should be specified in the target box.

You can select between four codec options: ProRes 422 LT, ProRes 422, ProRes HQ, 
and ProRes Proxy.

There is also an option to select the size of the recording. There are a few common 
video sizes listed, but you can also specify that the recording should match the size of 
your ProPresenter output.

Lastly, you can select whether to record 30 or 60 frames per second.

Pressing the record button in the bottom right will begin recording. When you are ready 
to stop recording, press stop and a file will be created at the specified target. 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Cues/Cue Palette
In ProPresenter 6, almost every action can be added as a cue on a slide. The Cue 
Palette makes it easy to see these cues in one place, and it can be opened by right-
clicking on any slide and selecting Add Cue > Cue Palette.

Clear Cues allow a slide to clear a different slide layer. These function the same way as 
clicking one of the Clear buttons at the top left side of the toolbar.

Media Cues allow you to quickly add a Video, Image, Audio or Live Video cue to a slide.

Stage Display cues allow you to change to a pre-defined layout on the Stage Display. 
For example, at the beginning of a song, you could select the “Song” layout, but at the 
beginning of a teaching, you could select the “Teaching” layout.

Multi-Screen cues allow you to change to a pre-defined Multi-Screen layout. (Note that 
the Multi-Screen cues are only available if you have the Multi-Screen Module active on 
that computer.)

Timer cues allow a slide to perform a specific action for any timer. The options are Start 
Timer, Stop Timer, Reset Timer, and Reset and Start Timer. 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Localization
ProPresenter includes support for several localizations including English, Spanish, 
Portuguese, and Korean. Simply change your computer's language preferences and 
ProPresenter will update to match.

To update your Localization on a Mac:
• Click on the Apple in the top left of the screen and go to System Preferences
• Click on Language & Text
• Select Elglish, Spanish, Portuguese, or Korean

To update your Localization on a PC:
• Go to this Microsoft article page
• Select your operating system from the top row
• Follow the instructions for installing the Elgish, Spanish, Portuguese, or Korean 

language pack
• Note that Portuguese is not supported in ProPresenter 5 on a PC
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Modules
Each of the features covered in this section of the user guide require an additional 
purchase of an unlock code, and in some cases additional hardware is required. For 
information about pricing, please visit our website.

Unlike a ProPresenter license, modules are licensed per computer and do not have a 
campus license option. If you require the same module on multiple computers, you will 
need to purchase multiple copies of the module. 

Modules are linked directly to an individual computer, however you have control over 
which computer it is licensed on. You can always Deactivate a Module on one computer 
and Activate it on another computer (as long as both computers are using the same 
ProPresenter Unlock Code). See the Modules page in the Preferences section above for 
more information on how to activate and deactivate Modules. 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Demo Modules and Registering Modules
ProPresenter makes it easy to demo modules. To access these options, open 
ProPresenter Preferences and click on the Modules tab. You will see the interface shown 
below.

If you have purchased modules in a previous version of ProPresenter on this same 
computer, they will have been automatically upgraded to ProPresenter 6 and will show 
has already being purchased.

To demo the modules, click the Demo Module button at the bottom of the menu. This 
will activate all of the modules in Preferences. When you activate a demo module, a 
watermark will be applied to your output screen. Modules are also only active for the 
current session of ProPresenter; when you close and re-launch the program, you will 
need to active the demo modules again. Demo modules are intended for determining if 
they will fit your needs and are not intended to be used in a live event. No temporary trial 
codes for modules will be available.

If you want to purchase a module, click on the blue Buy button. This will open the in-app 
store where you can purchase the module. Modules purchased this way will 
automatically be registered and activated on the same computer.

If you have purchased a module through a different route (such as on our website), 
restart ProPresenter and open the Module tab in Preferences; you should see an 
Activate button that you can click on to Activate the module on your computer. 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Alpha Key Module
The Alpha Key Module has two functions: (1) Blend ProPresenter’s content over 
incoming video and then send that combined content back to a switcher or projector; (2) 
Generate a key and fill signal that is then sent to a broadcast-quality switcher that is able 
to accept this type of signal.  You can also send the keyed signal out over NDI should 
you choose.  

When using method one, the actual compositing of the incoming video signal and the 
content in ProPresenter (text or lower-third graphics normally) is done on the video card 
itself and then sent back out to a switcher or projector. Choose this method by selecting 
Internal from the drop-down menu.

The second method sends what are referred to as a “key and fill signals” to your 
switcher allowing you to have a broadcast-quality signal. Choose this method by 
selecting External from the drop-down menu.

These are the settings that you should set on the HD-SDI tab in Preferences.

• Check the box for Enable Output Device and choose either the BlackMagic device 
you are using or NDI depending on your output choice.

• For the Mode setting, choose the appropriate setting whether it be standard definition 
(NTSC) or High Definition (720p, 1080p).

• The Compression setting should be left blank.

Finally, you will need to specify what kind of keying you wish to do under the "Alpha Key 
Settings" section:

• Disabled: This will output a full video out signal to your program and preview ports on 
the BlackMagic device or send the keyed output over NDI

• Internal Key: If you are using the Alpha Keyer as a downstream key, with a video input 
coming into the BlackMagic device and one going out of it, then this is an Internal Key 
(be aware that audio is passed through the BlackMagic device when using this mode -- 
you cannot use the Blackmagic audio outputs for sound out of ProPresenter when this 
mode is active).

• External Key: If you are sending separate key and fill outputs to your broadcast video 
switcher, this is the option you will choose. It sends the key signal through the preview 
out of the BlackMagic device and the fill out of the program output.

Set the Blend to specify the maximum opacity of the video overlays.

In addition to configuring the Alpha Key settings on the Advanced tab, you will also need 
to ensure a few settings are correct on the Display tab.

In Preferences, click the Display tab and ensure that the Display at Top Most Window 
Layer is not checked. You also need to manually enter the output resolution for your SDI 
signal. If your output doesn’t look correct, verify that the Output Screen resolution is set 
for your SDI signal and not the connected DVI or VGA display. 
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For SDI output, if you are still having trouble with the signal, open the Blackmagic 
preference panel in System Preferences and make sure that Remove field jitter when 
video is paused is not checked and that When not playing video, send is set to 
Black. Both of these options are on the bottom of the Setting tab in the Blackmagic 
preferences panel.

As of version 6.4 (released in April 2019), the ability to simultaneously output over SDI 
and NDI has been added. 

For this option, you will first set your BlackMagic device in the Device dropdown menu, 
and once selected, you will also see a check box appear that says “Enable Secondary 
NDI”. Once enabled, you will be able to send your ProPresenter output simultaneously 
over SDI and NDI.  

There are two limitations to this feature:  
- When using both of the SDI and NDI outputs, audio will not send over the NDI 
connection.  
- When “Secondary NDI” is enabled, the mode for NDI will automatically use the same 
frame rate mode that you set for your Blackmagic device but always in Progressive. So, 
if you have 1080i59.94 set as the “mode” for your Blackmagic device, NDI will 
automatically send 1080p59.94. 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Edge Blending Module
The Edge Blending module makes it easy and affordable to use edge blending in your 
environment. Edge blending consists of two or three overlapping projected images that 
have the overlapping regions adjusted to create a seamless blend. Because the outputs 
of each projector have to overlap in order for blending to occur, the actual width of your 
output will be smaller than the output resolution.

Before you make your adjustments to the Edge Blending Module, you will need to 
configure a Matrox DualHead2Go or TripleHead2Go, as well as your computer and 
ProPresenter, for the proper resolution. Refer to the Matrox Configuration section later 
in this user guide for details on setting up a Matrox DualHead2Go or TripleHead2Go.

Once you have properly configured your computer and ProPresenter to work with 
double-wide or triple-wide outputs, you can configure the Blend module. First set the 
Number of Projectors that you will be using, then set the Screen Ratio height and 
width. Note that this will be the ratio (size) of your physical screen; if you know the 
dimensions of your screen you can enter them here, or you can measure your screen 
with a tape measure and put in the measurements in the Height and Width boxes. Once 
you have your settings correct, check the Enable Edge Blending box to turn on the 
feature. Information about your Edge Blend will show in the text box in the middle of the 
window.

Next you may want to use the blend grid to help you align your projectors and get them 
as perfectly aligned as possible before adjusting the blend settings. In the View menu 
select Test Patterns, then select Show Blend Grid. Getting the alignment perfect is 
critical to being able to achieve the best edge blend possible. If your projectors are 
slightly out of alignment, your blended area will be more noticeable. 

The lower section is used to adjust your blend areas. The black-and-white box is actually 
the representation of the curve being used to apply the blending adjustments. The three 
options--Linear, Cubic, and Quadratic--will result in slightly different blends. Test each 
option to see which works best for you since this varies depending on projectors and 
environmental factors.

The four sliders allow you to adjust the values of the blend. You will need to spend some 
time working with these to get the best blend you can. It’s recommended that you start 
with the first two sliders, Blend and Intensity, at 100% to help you establish a good 
baseline for adjusting your blend. Gamma adjusts the brightness of the non-blended are 
compared to the blended regions. If you find that your blended areas are brighter than 
the rest of your screen, you will want to adjust this settings. Black Level adjusts the 
video black brightness. Since a projector doesn’t display black, the brightness between 
the blended area and the rest of the screen may vary slightly.

Due to the wide range of projects and their quality, achieving a “perfect” edge blend is 
quite difficult, even for the most skilled person. Due to many factors, such as quality of 
the projectors, age of the lamps in the projectors, number of hours each projector has 
been used, and even the brand of the lamps in the projector, you may still see a slightly 
visible area where the images overlap. This occurs with any edge blending solution. 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Master Control Module
The Master Control Module allows one Master ProPresenter station to remotely trigger 
slides and Video/Image Bin contents of one or more networked ProPresenter Slave 
stations. Each Slave station can have its own content suitable for its output, so it can be 
the same or different material than the Master station.

The ProPresenter stations must first be networked together. To ensure that all signals 
are properly sent to the Slave stations we recommend using a wired network, though a 
wireless network will work.

Once the computers are on the same machine, head to the Slave computers, and in the 
Network tab in Preferences click on Enable Network, then click on Enable Master 
Control, then select Slave. Note that the Network Name at the top will be autofilled, but 
you may want to update this if you need to clarify between different computers. The Port 
will also autofill; this rarely needs to be adjusted.

Next, on your Master computer, after you have Activated the Master Control Module, 
click on the Network tab in Preferences, click on Enable Network, then click on Enable 
Master Control, then select Master. At this point you should see your Slave computers 
listed.

Click the Connect button for each of the Slave stations. Optionally, you can also check 
the Reconnect checkbox which means that this station will always automatically 
connect when it becomes available.

From this point, when you click on a slide on the Master station, the corresponding slide 
will be displayed on the Slave station. For example, if you click on the first slide in the 
first playlist document on the Master station, the first slide in the first playlist will be 
displayed on the Slave station.

Similarly, when you click on an item in the Video/Image Bin on the Master station, the 
corresponding item will be displayed on the Slave station. 

You only need to purchase the Master Control Module for each Master computer; 
the Slave functionality is built into ProPresenter so you can connect as many Slave 

computers as you want to a Master computer. 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Multi-Screen Module
The Multi-Screen module allows you to extend your projection from one screen to two or 
three screens. 

Refer to the Matrox Configuration section later in this user guide for details on setting up 
a Matrox DualHead2Go or TripleHead2Go. This section will assume that your computer 

and hardware have been properly configured.

Once you have enabled the Multi-Screen module, you can select either Dual Screen or 
Triple Screen from the drop-down menu.

The Multi-Screen Module allows you to use one default configuration, or to create 
multiple layout cues that can change the layout on demand. To create a new layout, click 
on the plus button and name the new layout. Select a layout and press the Delete key to 
remove a layout. These layouts can be used by right-clicking on slide thumbnails and 
selecting the cue from the “Add Multi-Screen Setting Cue”.

The options not he right half of this preference menu allow you to designate which 
elements are shown on which screen. Use the Alternative Template (“Alt Template”) to 
apply a Template to specific screens so that your text can be reformatted just on those 
screens (for lower thirds, for example).

If you have certain elements in a template and they don’t exist in the Alt. Template (e.g., 
Text Reveal settings), those won’t be used. So if the certain screen is doing a text reveal, 

but the Alt Template on the side screens doesn’t have a text box with the same Text 
Reveal setting enabled, the full text will be shown immediately.

Once you have create the layouts that you want to use, you’re ready to go. If you create 
multiple layouts, the one that is selected will be the one that is used by default. If you 
want to change to a different layout on cue, right-click on a slide and select the 
appropriate layout from the Multi-Screen cue menu.

Selecting Tile next to video with cause your video or graphic to be shown on each of the 
three screens. Leaving this box unchecked will extend the same video or graphic all the 
way across your attached displays.

DVD clips can only be shown on one screen. Due to how DVDs are played we aren’t 
able to provide any additional control over the positioning of DVD playback. Web pages 
will be shown stretched across all three screens. The Multi-Screen module doesn’t affect 
the Stage Display and both can be used simultaneously.

Masks can be used with a Multi-Screen set up, but you will need to create a custom 
sized Mask layer sized to your output resolution. To do this, open the Mask module, click 
on the Edit button, click on the Document Properties tab, and enter a custom size for the 
resolution. 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SDI/NDI Output Module
The SDI/NDI Output module allows you to send an SDI or NDI signal directly to 
supported hardware.

To enable SDI or NDI output, open ProPresenter Preferences from the menu bar and 
select the HD-SDI tab. Then choose the appropriate Blackmagic device or NDI option 
and the mode that is required for your video system. 

This module is designed to work with BlackMagic video devices only for SDI output.

In Preferences still, click the Display tab and ensure that the Display at Top Most 
Window Layer is not checked. You also need to manually enter the output resolution for 
your SDI or NDI signal. If your output doesn’t look correct, verify that the Output Screen 
resolution is set for your SDI or NDI signal and not the connected DVI or VGA display. 

For SDI output, if you are still having trouble with the signal, open the BlackMagic 
preference panel in System Preferences and make sure that Remove field jitter when 
video is paused is not checked and that When not playing video, send is set to 
Black. Both of these options are on the bottom of the Setting tab in the BlackMagic 
preferences panel.

As of version 6.4 (released in April 2019), the ability to simultaneously output over SDI 
and NDI has been added. 

For this option, you will first set your BlackMagic device in the Device dropdown menu, 
and once selected, you will also see a check box appear that says “Enable Secondary 
NDI”. Once enabled, you will be able to send your ProPresenter output simultaneously 
over SDI and NDI.  
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There are two limitations to this feature:  
- When using both of the SDI and NDI outputs, audio will not send over the NDI 
connection.  
- When “Secondary NDI” is enabled, the mode for NDI will automatically use the same 
frame rate mode that you set for your Blackmagic device but always in Progressive. So, 
if you have 1080i59.94 set as the “mode” for your Blackmagic device, NDI will 
automatically send 1080p59.94.

Page �  of �129 147



Communication Module
The Communication Module provides connectivity to external devices via network or 
serial communications according to what the protocol supports. The Communication 
Module consists of a number of different protocols which can be organized into three 
groups. This module supports the following: AMP, VDCP, Sony BVW, GVG100, Sony 
BVS, GlobalCache, RossTalk, DMX, and MIDI.

Purchasing the Communication Module gives you access to any of these protocols. You 
can also choose to purchase MIDI as its own module. After you have purchased the 
Communication Module you will see the new Communication tab in Preferences. 

A working knowledge of the protocol you need to use is strongly recommended as each 
protocol has various options available and they are not covered in great detail in this 
guide. Due to the variety of configurations for these protocols, we can’t offer much 

support. Protocol specifics should be available in product manuals or from hardware 
manufacturers. 

Playback Deck/Media Server Control Protocols
These protocols include AMP, VDCP, and Sony BVW. AMP and VDCP are media server 
protocols that have more capabilities than Sony BVW such as triggering clips by name. 
BVW can only control the playback of an already triggered clip.

Switcher Control Protocols
These protocols include GVG100, Sony BVS, and RossTalk. These protocols can 
control a switcher, allowing you to remotely enable and disable keys or fade to black.

Sony BVS is preferred over GVG100 when available since it has greater capabilities.
RossTalk is a proprietary protocol supported by some Ross switchers. RossTalk is the 
preferred choice for a compatible Ross switcher because it uses network communication 
rather than serial. RossTalk is supported as 2 modes, Device and Controller. In 
Controller mode, ProPresenter can send commands to a connected Ross switcher. In 
Device mode, RossTalk provides some control of ProPresenter from a compatible Ross 
switcher. For Device mode, the Ross switcher is setup to connect to ProPresenter as if it 
were an Expression CG machine. Once connected, Up/Down on the switcher will 
advance through the items of the selected  playlist, and next will trigger slides or videos 
just like pressing the spacebar/right arrow key on  the ProPresenter machine. Note that if 
you want to use both Controller and Device modes for RossTalk, you must configure 2 
RossTalk devices, one for each mode as these modes require two different network 
connections.

You can also clear the output using the Clear Layer command where the layers 
correspond to the different ProPresenter clear commands as follows:

Layer 0 Clear All
Layer 1 Clear Live Video
Layer 2 Clear Background
Layer 3 Clear Slide
Layer 4 Clear Props
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To add any of the available protocols to ProPresenter, click on the Add Device button in 
the lower right corner and select the protocol from the list. Each protocol has unique 
configuration settings. We have set each protocol to use the standard configuration as 
specified by each manufacturer. If your configuration requires different settings you will 
need to refer to the documentation for the device you are connecting to with 
ProPresenter. The screenshot below shows GVG100 as an example.

After you have added a protocol, you will see a box that shows you the active protocols. 
You can connect or disconnect any protocol, or remove it, from here. If you need to 
change the settings for a protocol, click on the gear icon to open the settings menu.

Click on MIDI Setup or DMX Setup to modify these protocols.

The following screenshot shows several of the protocols listed at the same time. 
ProPresenter is capable of supporting more than one protocol at the same time, within 
reason. Some protocol combinations don't make sense to run at the same time, like AMP 
and VDCP, but some do like AMP and RossTalk.

Page �  of �131 147



DMX and MIDI Protocols
Both of these protocols allow the user to define the DMX channels or MIDI notes that are 
mapped to the various controls for ProPresenter. DMX is fixed to a sequence of 
contiguous channels just like a lighting fixture, whereas MIDI allows you to map any note 
to a given MIDI controllable ProPresenter command. These settings are defined in the 
Communication preference pane in ProPresenter under the DMX and MIDI buttons.

MIDI is covered extensively in the next section.

The DMX configuration allows you to define the starting channel and displays how the 
other channels are mapped. DMX supports ArtNet over a network only. USB-DMX 
interfaces are not supported. The screenshots below show a standard DMX setup. 
These values are entered by clicking on the DMX Setup button in the Communication 
Module. Note that for the first item you can manually select if that command will select a 
Playlist or select a Document within the current Playlist.

In the Communication preference pane you can setup devices which persist in 
ProPresenter until you remove them. They may optionally automatically reconnect when 
ProPresenter is relaunched. From this preference pane you can also configure the DMX 
and MIDI options. In addition, there's a checkbox for whether to allow filenames longer 
than eight characters for VDCP and AMP.
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VDCP and AMP require a Video/Image Bin playlist to be designated as the Comm 
Module playlist. This is the playlist that is used to select clips with either of these 
protocols. You can designate any Video/Image Bin playlist as your Comm Module 
playlist by right-clicking on the playlist name. The display name of each video in this 
playlist must be unique and will be modified as necessary to make it unique. If the eight 
character filename option is checked, the display name will also be trimmed to eight 
unique characters as necessary. Consult your video switcher's manual to determine 
whether you need to enable the 8 character filename limit. If the switcher doesn't support 
variable length filenames, then you'll need to enable that option in ProPresenter.

For a switcher control protocol, an option will appear in the contextual menu of any slide 
to add a switcher control cue to that slide. Any time that slide is triggered, the chosen 
command is sent to the switcher if it's connected.
 

Assigning module commands to slides

When you have enabled a protocol that supports sending commands, you will be able to 
assign those commands to specific slides. Each protocol supports different cue options, 
so the menu that you see will be different. If you only have a single protocol assigned, 
you will not have the sub-menu of protocols. GVG100, RossTalk (Controller mode), and 
Sony BVS are the only protocols that have slide cues available.
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Using RS-422 Serial with Communications Module

RS-422 is a serial standard that defines how the serial signal is transmitted 
electronically. There are several serial standards including RS-232 and RS-485. Note 
that these standards are electrically different and are not compatible even though in 
many cases they use the same DB-9 connector. Unfortunately, there are different, 
incompatible ways that RS-422 may be wired through a standard DB-9 connector. There 
are two common DB-9 pinouts that are used with RS-422 in the context of video 
production equipment. Depending on your computer serial interface, you may be 
required to create a cable or use adapters to convert from one pinout to another. In 
addition, you may have to compensate for a pinout on a serial interface that doesn't 
match either of these common pinouts.

Here are the two common pinouts:

These pinouts were originally used on tape based playback decks and have since been 
used on media servers and video switchers as well. The Deck Control Master pinout 
would typically be found on a controlling device such as an editor or video switcher. The 
Deck Control Slave pinout would typically be found on a playback deck that is to be 
controlled via serial.

There are two common types of RS-422 computer interfaces you might run into. One is 
the serial port on video hardware such as BlackMagic Decklink cards or UltraStudio 4K 
devices. There are other similar devices such as those made by AJA which also have 
RS-422 ports, however we have discovered that AJA does not properly set their serial 
port configuration. In at least some of their devices (namely the ioXT), the serial port is 
fixed to a certain baud rate, parity, etc. and cannot be changed, as confirmed by AJA. 
Unfortunately, none of the manufacturers we talked to really support the serial port on 
their video hardware as a general purpose serial port, they tend to only support it when 
used with their own software. However, we found that the serial port on BlackMagic 
hardware was very reliable.

The other common RS-422 interface is a simple RS-422/USB adapter. Note that this is 
not the same thing as (and not compatible with) an RS-232/USB adapter which is much 
more common. RS-422/USB adapters are typically designed for use in computing 
environments rather than video production environments, therefore they will typically 

Deck Control Slave
DB-9, usually Female
Pin 1 -> Ground
Pin 2 -> Tx -
Pin 3 -> Rx +
Pin 4 -> Ground
Pin 5 -> Nothing
Pin 6 -> Ground
Pin 7 -> Tx +
Pin 8 -> Rx -
Pin 9 -> Ground

Deck Control Master
DB-9, usually Male
Pin 1 -> Ground
Pin 2 -> Rx -
Pin 3 -> Tx +
Pin 4 -> Ground
Pin 5 -> Nothing
Pin 6 -> Ground
Pin 7 -> Rx +
Pin 8 -> Tx -
Pin 9 -> Ground
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have a pinout that differs from the two specified above. In our limited testing, we have 
had mixed results with RS-422/USB adapters. There are also RS-422/RS-232 
converters which may work in conjunction with a common RS-232/USB adapter. We 
have not tested this setup.

Serial ports that are found on video hardware interfaces such as those made by 
BlackMagic typically have a Deck Control Master pinout configuration. When using the 
VDCP, AMP or Sony BVW protocols to control video playback in ProPresenter, the 
computer's serial port needs to be a Deck Control Slave configuration instead. This 
requires a custom cable or the use of adapters to switch the transmit and receive pins. 
When using GVG100 or Sony BVS editor protocols to control a video switcher, the editor 
port on a video switcher typically matches the Deck Control Slave pinout so this works 
with a BlackMagic serial port with just a straight through serial cable.

One of the easiest ways to create the necessary DB-9 cable for whatever pinout you 
need, is to use two DB9/ethernet adapters connected with a straight thru ethernet cable. 
These inexpensive adapters are available from monoprice
http://www.monoprice.com/products/product.asp?p_id=1151
http://www.monoprice.com/products/product.asp?p_id=1152

The adapters come ready to assemble. You insert the colored leads from the ethernet 
jack into the appropriate pins of the DB9 connector. Here is a common configuration 
used to swap the transmit and receive lines for using a BlackMagic serial port as a Deck 
Control Slave with the VDCP, AMP or Sony BVW protocols in ProPresenter:

The goal in creating the proper cable is to connect the Receive lines Rx-/Rx+ with the 
Transmit lines on the other end Tx-/Tx+, as well as connecting the ground pins. The 
polarity of the Rx/Tx connection should match, so Rx- should be connected to Tx- and 
Rx+ should be connected to Tx+. This process is the same regardless of what serial 
interface you are connecting to. For RS-422/USB adapters or other RS-422 serial ports, 
you may need to consult the documentation for your device to get the pinout.

Adapter 1:
DB9 Pin 1 <-> White 
DB9 Pin 2 <-> Blue
DB9 Pin 3 <-> Yellow
DB9 Pin 4 <-> Red
DB9 Pin 5 <-> Nothing
DB9 Pin 6 <-> Green
DB9 Pin 7 <-> Orange
DB9 Pin 8 <-> Black
DB9 Pin 9 <-> Brown
(Colors are the Ethernet 
leads.)

Adapter 2:
DB9 Pin 1 <-> White
DB9 Pin 2 <-> Black
DB9 Pin 3 <-> Orange
DB9 Pin 4 <-> Green
DB9 Pin 5 <-> Nothing
DB9 Pin 6 <-> Red
DB9 Pin 7 <-> Yellow
DB9 Pin 8 <-> Blue
DB9 Pin 9 <-> Brown
(Colors are the Ethernet 
leads.)
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MIDI Module
The MIDI Module can be purchased separately or as part of the broader Communication 
Module.

The MIDI configuration allows you to auto-fill all the commands from a starting note, or 
you can assign any MIDI note to a given command. You must ensure that you don't 
assign the same MIDI note to multiple commands since this will result in undefined 
behavior. MIDI connections are supported for any CoreMIDI device. Network devices 
may be configured via OS X's Audio MIDI Setup utility.

Audio MIDI Setup is found in /Applications/Utilities in the Finder.

After you have opened Audio MIDI Setup, click on the Window menu and select Show 
MIDI Window.

Double-click on the Network icon on the MIDI Studio screen.
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After you double-click on Network, you will see the MIDI Network Setup panel. This is 
where you create your session that will allow your MIDI controller and your Mac to 
interact. The screen shot below shows the completed configuration; the steps below the 
screenshot will guide you through the setup.

To setup your session, click on the plus (+) button under My Sessions. This will create a 
default session titled “Session 1”. This name doesn’t matter so you don’t need to change 
it. Check the box next to “Session 1”. After a few moments, you will see available 
devices in the Directory listing. Select the device and click Connect. Change the Who 
may connect to me option to Anyone. Verify that Enabled is selected at the top of your 
Session settings. You do not need to make any other changes. Do not select anything 
for Live routings or your connection may not work properly.

Now that you have configured Audio MIDI Settings for your Mac, you are ready to setup 
ProPresenter’s MIDI controls.

Return to ProPresenter and the Communication Module settings in Preferences.  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Click on the Device menu in the lower-right corner of the module and add a new MIDI 
device. Select the correct device that you have setup to be used with your Mac. Click 
Save and then Connect after you have finished configuring the rest of the MIDI settings.

Click on the MIDI Setup button to open the MIDI communication settings. MIDI notes 
range from 0 to 127. Entering a number next to Auto Fill and then clicking the button will 
fill all of the values beginning with your chosen value. If you want each section to start at 
a different, type your starting value in the first box of each list and then click the Auto Fill 
using the first value in each Form at the bottom.

MIDI values cannot be shared between commands. For example, you could not assign 
All: 48 and Next Playlist: 48 at the same time.
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ProPresenter 6 also allows any slide to have a MIDI cue attached to it which will 
generate a MIDI note when that slide is clicked. 

To add a MIDI cue, right-click on a slide and select Add Cue > Communication Cue > 
MIDI and select either MIDI Note On or MIDI Note Off.

For each MIDI cue, you can specify the MIDI Channel, Note and Intensity. When the 
slide is displayed, the MIDI note will be sent through the MIDI interface that is configured 
in ProPresenter Preferences > Communications.
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Matrox Configuration
The Edge Blending module and the Multi-Screen module both require a Matrox 
DualHead2Go (DH2G) or TripleHead2Go (TH2G). We do not support any other 
hardware for these two modules.

We recommend downloading the latest software driver directly from Matrox’s website 
rather than installing the one on the CD. You can choose the version you need here.

The following instructions are only for the Digital Edition or DisplayPort Edition DH2G 
and TH2G. If your computer has a MiniDisplayPort or ThunderBolt connection, you must 
use the DisplayPort Edition.

Select EDID Management from the drop down list.

If you have not connected your Mac to your DH2G or TH2G, you will be guided through 
this process first. Once you have connected the hardware, you will see a screen like the 
one below.
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The left side of the screen allows you to choose the display settings you need to use. 
Make those selections then click on the right arrow to add the resolution to the Active 
Resolutions and Refresh Rates list. If your resolution is already listed, you don’t need 
to make any changes. When you are done, click Apply Changes.

Refer to the Configuring your computer for first use section for instructions on 
selecting the resolution for your secondary display. You should have a high resolution 
that matches what you selected in the Matrox Control Panel. If you selected 3 * 800x600 
60 Hz in the Matrox settings, you should have a resolution option of 2400 x 600 60 Hz in 
the system display settings.

You will know you have properly configured your displays when you see the default 
desktop image spanning all three displays. If you do not see this, try restarting your 
computer and then going through the steps again. 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Display Patterns
ProPresenter 6 has several different display patterns built into the program to make it 
easier for you to adjust projectors. These can be found by clicking on the View menu, 
clicking on Test Patterns, and selecting the pattern you want to use from the left hand 
menu. A few of these options are shown below.

Blend Grid makes it easy to configure overlapping projector 
images.

Focus provides easy reference for focusing and adjusting key 
stone.

Color Bars is useful for calibrating the color of your projectors. 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Keyboard Shortcuts

Command Mac Shortcut Windows Shortcut
ProPresenter Menu

Preferences Command-Comma Control-Comma
Empty Cache Command-Control-E Control-Shift-E
Quit ProPresenter Command-Q Alt-F4

File Menu
New Presentation Command-N Control-N
Save All Command-S Control-S
Print Command-P Control-P

Edit Menu
Undo Command-Z Control-Z
Redo Command-Shift-Z Control-Y
Cut Command-X Control-X
Copy Command-C Control-C
Paste Command-V Control-V
Paste and Match Style Command-Option-Shift-V Alt-V
Duplicate Slide Command-Shift-D Control-Shift-D
Delete Delete Delete
Select All Command-A Control-A
Deselect Command-D Control-U

Actions Menu
Next Slide Space or Right Arrow Space or Right Arrow
Previous Slide Left arrow Left arrow
Next Background Command-Right Arrow Control-Right Arrow
Previous Background Command-Left Arrow Control-Left Arrow
Clear All F1 F1
Clear Slide F2 F2
Clear Background F3 F3
Clear Props F4 F4
Clear Audio F5 F5
Logo F6 F6
Live Video F7 F7
Search Library Command-F Control-F
Show Library Selection Command-L Control-L
Show Slide on Stage Display OnlyCommand-Zero Control-Zero
Record Output Command-Shift-R Control-Shift-O
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View Menu
Audio Bin Control-A Control-Shift-A
Bibles Control-B Control-Alt-B
Clocks/Timers Control-C Control-Shift-C
Cue Pallette Control-Shift-C Alt-C
DVD Control-D Control-D
Editor Control-E Control-E
Format Bar Control-F Control-Alt-F
Info Center Control-I Control-Alt-I
Mask Control-Shift-M Control-Shift-M
Messages Control-M Control-M
Planning Center Live Control-Shift-P Control-Alt-P
Props Control-P Control-Shift-P
Reflow Editor Control-R Alt-Shift-R
Resources Control-Shift-R Control-R
Scheduler Control-S Alt-Shift-S
Social Media Control-Shift-S Control-Shift-W
SongSelect Option-Shift-S Control-Alt-S
Stage Display Control Command-Shift-S Alt-S
Telestrator Control-T Alt-T
Video/Image Bin Control-V Control-Shift-V
Web Control-W Control-W

Format Menu
Bold Command-B Control-B
Italic Command-I Control-I
Underline Command-U Control-U
Bigger Command-Plus Control-Plus
Smaller Command-Minus Control-Minus
Copy Style Command-Option-C Control-Alt-C
Paste Style Command-Option-V Control-Alt-V

Window Menu
Output Window (On/Off) Command-1 Control-1
Stage Display Window (On/Off) Command-2 Control-2
Stage Display Preview Command-3 Control-3
Configure Stage Display Command-4 Control-4

Help Menu
Find my Mouse Option-M Alt-M

Editor
Send remaining text to new slideOption-Return Control-Enter

Command Mac Shortcut Windows Shortcut
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Send remaining text to next slideOption-Shift-Return Control-Shift-Enter

Command Mac Shortcut Windows Shortcut
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Troubleshooting
If you are having problems with ProPresenter operating properly, please verify that you 
have the latest updates installed for ProPresenter 6. If you cannot open the program, 
you can download the latest version from our website.

For further troubleshooting instructions, please visit http://forums.renewedvision.com. 
Access the correct support forum for your version of ProPresenter and refer to the 
Troubleshooting topic listed in each forum. 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Additional Resources
Tutorial Videos

There are a number of quick tutorial videos that will introduce you to the basics of many 
of the new features in ProPresenter 6. These are not intended to be training resources, 
but are simply to help you understand how features work and where things are located.

Click here to watch the tutorials.

Support Resources

You can access a wealth of information about ProPresenter and search for help in our 
knowledge base. This is available at: http://support.renewedvision.com

User Forums

Our user forums are a great place to get help from other users and from our support 
staff. You must create an account in the forums in order to post messages or replies, but 
this is a free resource. 

Phone and E-mail

You can find our direct contact information on our website.

Twitter

Follow us on Twitter at @RenewedVision, @ProPresenter, and @RVSupport.

Facebook

Like us on Facebook at FB.com/ProPresenter.
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